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@SAFETY PRECAUTIONS @

(Read these precautions before using this product.)

Before using this product, please read this manual and the relevant manuals carefully and pay full attention
to safety to handle the product correctly.

The precautions given in this manual are concerned with this product only. For the safety precautions of the
programmable controller system, refer to the user's manual for the CPU module used.

In this manual, the safety precautions are classified into two levels: "AWARNING" and "ACAUTION".

( )

é WARNING Indlcgtes.that incorrect handlllrjg may cause hazardous conditions,
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions,
ACAUTlON resulting in minor or moderate injury or property damage.

\_ J

Under some circumstances, failure to observe the precautions under “A CAUTION" may lead to serious

consequences.
Observe the precautions of both levels because they are important for personal and system safety.

Make sure that the end users read this manual and then keep the manual in a safe place for future
reference.

[Design Precautions]

/\WARNING

@ For the following controls, configure an interlock circuit in the user program to ensure that the entire
system will always operate safely.
(1) Changing data of the running C Controller module from the development environment (personal

computer) connected

(2) Changing the operating status
(3) Operation from the development environment (personal computer)
Especially, in the case of a control from an external device to a remote C Controller module,
immediate action cannot be taken for a problem on the C Controller module due to a communication
failure.
To prevent this, configure an interlock circuit in the user program, and determine corrective actions to
be taken between the external device and C Controller module in case of a communication failure.




[Startup and Maintenance Precautions]

/\WARNING

@ For the following controls, configure an interlock circuit in the user program to ensure that the entire
system will always operate safely.
(1) Changing data of the running C Controller module from the development environment (personal

computer) connected

(2) Changing the operating status
(3) Operation from the development environment (personal computer)
Especially, in the case of a control from an external device to a remote C Controller module,
immediate action cannot be taken for a problem on the C Controller module due to a communication
failure.
To prevent this, configure an interlock circuit in the user program, and determine corrective actions to
be taken between the external device and C Controller module in case of a communication failure.

[Startup and Maintenance Precautions]

/\CAUTION

@ Before performing online operations (especially, program modification, forced output, and operation
status change) for the running C Controller module from the peripheral connected, read relevant
manuals carefully and ensure the safety.

Improper operation may damage machines or cause accidents.




@CONDITIONS OF USE FOR THE PRODUCT@®

(1) Mitsubishi C Controller system ("the PRODUCT") shall be used in conditions;
i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major
or serious accident; and
ii) where the backup and fail-safe function are systematically or automatically provided outside of
the PRODUCT for the case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general
industries.
MITSUBISHI SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT
LIMITED TO ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT,
WARRANTY, TORT, PRODUCT LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR
LOSS OR DAMAGE TO PROPERTY CAUSED BY the PRODUCT THAT ARE OPERATED OR
USED IN APPLICATION NOT INTENDED OR EXCLUDED BY INSTRUCTIONS, PRECAUTIONS,
OR WARNING CONTAINED IN MITSUBISHI'S USER, INSTRUCTION AND/OR SAFETY
MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT.
("Prohibited Application")

Prohibited Applications include, but not limited to, the use of the PRODUCT in;

* Nuclear Power Plants and any other power plants operated by Power companies, and/or any
other cases in which the public could be affected if any problem or fault occurs in the PRODUCT.

+ Railway companies or Public service purposes, and/or any other cases in which establishment of
a special quality assurance system is required by the Purchaser or End User.

« Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as
Elevator and Escalator, Incineration and Fuel devices, Vehicles, Manned transportation,
Equipment for Recreation and Amusement, and Safety devices, handling of Nuclear or
Hazardous Materials or Chemicals, Mining and Drilling, and/or other applications where there is a
significant risk of injury to the public or property.

Notwithstanding the above, restrictions Mitsubishi may in its sole discretion, authorize use of the
PRODUCT in one or more of the Prohibited Applications, provided that the usage of the PRODUCT
is limited only for the specific applications agreed to by Mitsubishi and provided further that no
special quality assurance or fail-safe, redundant or other safety features which exceed the general
specifications of the PRODUCTs are required. For details, please contact the Mitsubishi
representative in your region.



INTRODUCTION

Thank you for purchasing CW Workbench.
This manual explains about the product.

Before using this product, please read this manual and the relevant manuals carefully and develop familiarity with the
functions and performance of CW Workbench and applicable modules to handle the product correctly.



RELEVANT MANUALS

The manuals related to the product are listed below.

Please place an order as needed.

Manual
<Manual No. and model code>

Description

C Controller Module User's Manual
(Hardware Design, Function Explanation)
<SH-080766ENG, 13J217>

The manual describes the system configuration, specifications,
functions, handling methods, wiring, and troubleshooting of Q12DCCPU-
V (Basic mode) and Q06CCPU-V.

C Controller Module User's Manual
(Utility Operation, Programming)
<SH-080767ENG, 13JZ18>

The manual describes the installation/uninstallation, utility operation,
instructions, and programming of Setting/Monitoring Tools for the C
Controller Module (SW3PVC-CCPU).

MELSEC-Q C Controller Module User's Manual
<SH-081130ENG, 13JZ75>

The manual describes the system configuration, specifications,
functions,handling methods, wiring, troubleshooting, and programming
and function of C Controller module (Q24DHCCPU-V, Q24DHCCPU-VG,
Q24DHCCPU-LS, Q26DHCCPU-LS, and Q12DCCPU-V (Extended
mode)).

Setting/Monitoring Tools for the C Controller Module
Operating Manual
<SH-081131ENG, 13JU76>

The manual describes the system configuration and operation method of
Setting/Monitoring Tools for the C Controller Module (SW4PVC-CCPU).

CW-Sim Operating Manual
<SH-081159ENG, 13JU77>

The manual describes the system configuration, specifications,
functions, and troubleshooting of CW-Sim.

Wind River Workbench 3.2 manuals

The manuals describe specifications, usage methods, troubleshooting,
and relevant documents of Wind River Workbench 3.2 that is the base
for this product.

Refer to the manuals for the same functions as Wind River Workbench.
A PDF file of the manuals is stored on the DVD-ROM disc of the product.
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MANUAL PAGE ORGANIZATION

The following illustration is for explanation purpose only, and should not be referred to as an actual documentation.

_Indicates the chapter of

I CHAPTER 8 CREATING AND BUILDING USER PROGRAM
currently open page.

3. select "C-Compiler" for "Build tool:".

Click the Tool Flags. button.

indicates
the useful tip.

L~

4. On the "Optimization" dialog box, select [Enable
maximum speed optimizations]. Check that "-02"
has been added to "Selected option:" and click the
0K | button. Indicates the section

3
v of currently open page.
=3
a3
o
2
El
15
&
o
2

O g

e
Point N Point £ indicates
oint .
1 the particular
To cancel the optimization option, click & | in "Enable Optimization" on "Optimization" and change the mark to .
& (cancel). Check that "-O™ has been deleted from "Selected option-" j attention.

<

To the next page

73

Operating procedures
Three styles of descriptions are used in this manual as below:

(1) When there is only one operation

O Menu bar [Help]=>[Help Contents]

(2) When there are steps

1. Copy the created source file to the current folder of a project to be added.

2. Sselect the project to be added on the "Project Explorer" window.

(3) When there are multiple operations

» Enter a folder name of the installation location and click the k. button.

« Afolder can be selected by clicking the  Brows=.. | button.
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Symbols used in this manual

The following shows the symbols used in this manual with descriptions and examples.

& Baszic Device Development — UserProject/Sample.c - CW Workbench

File Edit Source

@—»Fi [~
ﬁ‘:, Project Explorer A

Refactor

Mavigate

A A

-0l Build Targets (SHT7E0gnule)
s Wind River Launches

ﬁb Binaries

a heludes

= SHT7EDenulz
[ Samplec

% Properties for UserProject

brefrorma |

Resource

Build Properties

Specity all build properties.

Search

Project § relommsiinis sy v\t
Project References
Gloge Project

Cpen Wind River Wiorks 6.4 Development Shell

avp Build Al
Build Project

Clean...

Build Options

Binary Parser
Build Properties @ Euild Suppart and Specs | 5 Bulld Took $—Brritd-b Britd-Patie =i
Builders [
@ -+ /s General PEuild tool ‘C—Compller v|[ M. ] [Rename ] [ Capy... ] [ Delete.. ]
Project Info
Project References
Retactorine History Suffices [+ |
Run/Debug Settings ’ )
Tosk Tags Build output generation
Validation (&) Generated build output is an object
(O Generated build output is 3 build tarest
Build gpec specific settings
fictive build spec [SH7750erule v

Derived suffox

Cammand: i

Tool Flags i

Debug mode flaes
Debug mode. 7

"o

echo "building $@” Sccompilerprefixl $ITOOL PATHIcosh & ~
DebugModsF laesh ¥ToolFlaesk $1ADDED CFLAGS) ¥lnchudesk 3
$ADDED INCLUDES) -DGPU=SIGPL) - =
DTOGL_F AMILY=3TOOL_FAMILY? -DTOOL=3{TOOL) -0 WRS_KERNEL &

$IGC_ARGH SPEC) -ansi —Wall -MD -MP

e \

Man Detug mode..| & [-02 —fno-builtin
@ et —— ©®

No. Symbol Description Example
@ [ ] Menu name on a menu bar [Project]

@ i Toolbar icon 6

® " Screen name or item name on a screen "Build tool:"
@ << > Tab name on a screen <<Build Tools>>
® Button on a screen

Keyboard key

Reference page

Reference manual




GENERIC TERMS AND ABBREVIATIONS

Unless otherwise specified, this manual uses the following generic terms and abbreviations.

Generic term/abbreviation

Description

Q24DHCCPU-V

The abbreviation for Q24DHCCPU-V C Controller module.

Q24DHCCPU-VG

The abbreviation for Q24DHCCPU-VG C Controller module.

Q12DCCPU-V

The abbreviation for Q12DCCPU-V C Controller module.

Q12DCCPU-V (Basic mode)

Status that Q12DCCPU-V is initialized with the basic mode For Q12DCCPU-V (Basic
mode), refer to the following manual.

[ 71 C Controller Module User's Manual (Hardware Design, Function Explanation)

Q12DCCPU-V (Extended mode)

Status that Q12DCCPU-V is initialized with the extended mode For Q12DCCPU-V
(Extended mode), refer to the following manual.

MELSEC-Q C Controller Module User's Manual

C Controller module

The generic term for Q24DHCCPU-V, Q24DHCCPU-VG, and Q12DCCPU-V.

Setting/monitoring tools for the C
Controller module

The generic term for Setting/monitoring tools for the C Controller module shown below.
* Q24DHCCPU-V, Q24DHCCPU-VG, and Q12DCCPU-V (Extended mode)
SW4PVC-CCPU
* Q12DCCPU-V (Basic mode)
SW3PVC-CCPU

VxWorks

The real-time operating system manufactured by Wind River Systems, Inc.

Wind River Workbench

The generic term for Wind River Workbench manufactured by Wind River Systems, Inc.

CW Workbench

The engineering tool for C Controller module.
The generic term for OEM products of Wind River without the runtime analysis tool and
simulation functions (VxSim) of Wind River Workbench; a subset of Wind River
Workbench.
* Q24DHCCPU-V and Q24DHCCPU-VG

SW1DND-CWWLQ24-E, SW1DND-CWWLQ24-EZ, SW1DND-CWWLQ24-EVZ
*+ Q12DCCPU-V

SW1DND-CWWLQ12-E, SW1DND-CWWLQ12-EZ, SW1DND-CWWLQ12-EVZ

VxSim

The generic term for the VxWorks simulator functions of Wind River Workbench.

CW-Sim

The abbreviation for the VxWorks simulator that can operate the C Controller module
program on a personal computer with CW Workbench installed, without connecting to the
actual machine (target).

CW-Sim Standalone

The abbreviation for the VxWorks simulator that can operate C Controller module
program even on a personal computer without CW Workbench installed.

Windows® 7 or later

The generic term for Windows® 7, Windows® 8, Windows® 8.1, Windows® 10

Windows® 8 or later

The generic term for Windows® 8, Windows® 8.1, Windows® 10

Personal computer

. . ®
The generic term for personal computers where Windows  operates

11



TERMS

Unless otherwise specified, this manual uses the following terms.

Term Description

The generic term for bus interface function, MELSEC data link function, and C Controller

Dedicated function library . .
module dedicated function.

Dedicated function library offered by C Controller module.

This function is used when executing the following:

Bus interface function * Input from or output to I/O modules controlled by the C Controller module
* Access to the buffer memory of an intelligent function module

* The readout or control of the C Controller module status

Dedicated function library offered by C Controller module.
MELSEC data link function This function is used when writing to/reading from a device of other programmable
Controller CPUs connected via network or configured with multiple CPUs.

Dedicated function library that controls C Controller module.
This function is used when reading the C Controller module status, controlling LED, and
C Controller module ) .
accessing to resources such as time and battery backup RAM.
This function can be used for Q24DHCCPU-V and Q24DHCCPU-VG C Controller modules.

It can not be used in Q12DCCPU-V C Controller module.

The abbreviation for Uniform Resource Locator.
URL This address indicates a location of information resources (such as text and images) on the

dedicated function

Internet.

Eqli An open source software development environment comprising an integrated development
clipse . . .
environment written in Java

PRODUCT ORGANIZATION

The following shows the C Controller-compatible software.
O: Applicable, X: Not applicable

C Controller
Q24DHCCPU-V
Q12DCCPU-V
Supported Q24DHCCPU-VG
software Earlier than
- "15102" or later *1
"15102" *1

- Extended mode Basic mode *2
SW1DND-CWWLQ24-E O X X X
SW1DND-CWWLQ12-E X O O @)

*1 First five digits of serial number
*2 For Q12DCCPU-V earlier than "15102", the mode cannot be changed. Q12DCCPU-V earlier than "15102" is regarded
as the basic mode in this manual.



CHAPTER 1 OVERVIEW

CHAPTER 1 ovErRVIEW

CW Workbench is a product for customers who develop a user program that operates on the C Controller module.
CW Workbench is an OEM product of Wind River Systems, Inc. The product has only basic functions required for user
program development, such as coding, building, and debugging, as a subset product of Wind River Workbench 3.2.

1 .1 Features

Engineering tool for C Controller, CW Workbench, is software to offer dedicated integrated development environment
for the Mitsubishi C Controller module.
CW Workbench has the following features:

(1) Software to offer dedicated integrated development environment for the C

Controller module
This product is an integrated development environment to execute the following operations: project management,
source code editing, building, and debugging. A user program for the C Controller module can be effectively

developed.

(2) The same specifications as those of Wind River Workbench 3.2
Displays and operations of CW Workbench are the same specifications as those of Wind River Workbench 3.2 for

common functions.

(3) Extended functions using plug-in software
The third party plug-in software can be easily added, which allows functions to be easily extended.

saimead ||
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CHAPTER 2 sYSTEM CONFIGURATION

2.1 Environment Configuration for Each License Type

This section explains the environment for developing user programs in CW Workbench.

A permanent license is required to install CW Workbench. ([ Page 22, Section 5.1)

(1) Product with license

C Controller module

=" Permanent j Permanent

=_ 1 . X'il .
’Vﬂ license <:| 1 | License

= file Application Form

CW Workbench
CW Workbench (SW1DND-CWWLQ12-E,
User program creating and building SW1DND-CWWLQ24-E)

(2) Additional license product

=" Permanent ] Permanent
= X X’il .
’VE' license <:| || | License

= file Application Form
C Controller module p ~
CW Workbench
(SW1DND-CWWLQ12-EZ)*’
- J
. N\

CW Workbench
(SW1DND-CWWLQ24-EZ)*

-
4 N
CW Workbench
CW Workbench (SW1DND-CWWLQ12-E,

User program creating and building ~ \_ SW1DND-CWWLQ24-E) )

*1 The DVD-ROM is not included with the CW Workbench additional license product (SW1DND-CWWLQ12-EZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license (SW1DND-CWWLQ12-
E) is required.

*2 The DVD-ROM is not included with the CW Workbench additional license product (SW1DND-CWWLQ24-EZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license (SW1DND-CWWLQ24-
E) is required.

14



CHAPTER 2 SYSTEM CONFIGURATION

(3) Updated license product

C Controller module C Controller module
(Q12DCCPU-V)*? 2 (Q24DHCCPU-V/-VG)

User program debugging User program debugging
(SW1DND-CWWLQ12-E) (SW1DND-CWWLQ24-E)

=77 Permanent Permanent
= XI
’;’J license <:| . | License

= file —! Application Form

[ CW Workbench j ﬁ
(

SW1DND-CWWLQ24-EVZ)*!

o

CW Workbench

CW Workbench (SW1DND-CWWLQ12-E)
User program creating and building

(SW1DND-CWWLQ12-E *2+ SW1 DND-CWWLQ24-E)

*1 The DVD-ROM is not included with the CW Workbench updated license product (SW1DND-CWWLQ24-EVZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license
(SW1DND-CWWLQ12-E) is required.

*2 The configuration before installing the updated license product (SW1DND-CWWLQ24-EVZ) is indicated.

Point/

If the CPUs to be used after update are not written in "Target CPU" of Permanent License Application Form, please consult
your local Mitsubishi representative.

adA ]| esueoi yoed Joy uoneinBiuoy JUSWUOIIAUT |°Z
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2.2 Relevant Module

CW Workbench is compatible with the following C Controller module:

Model Operating System Relevant software package
Q24DHCCPU-V SW1DND-CWWLQ24-E
VxWorks 6.8 SW1DND-CWWLQ24-EZ
Q24DHCCPU-VG SW1DND-CWWLQ24-EVZ

SW1DND-CWWLQ12-E
Q12DCCPU-V VxWorks 6.4 SW1DND-CWWLQ12-EZ
SW1DND-CWWLQ12-EVZ

2.3 Operating Environment

16

Below is a list of the operating environment of a personal computer where CW Workbench can be operated.

Item Description
PC/AT-compatible personal computer in which the following operating systems can be
Computer
operated.
CPU Intel®Core ™2 Duo 2GHz or higher is recommended.

Memory requirements | 1G byte or more (2G bytes or more is recommended)

Install size: HDD 4G bytes or more

Hard disk space . .
Executable size: Virtual memory 512MB or more

Display 1024-by-768 resolution or higher
Disk drive DVD-ROM drive
Interface Ethernet 10BASE-T/100BASE-TX/1000BASE-T

- Windows 10 (Home, Pro, Enterprise, Education, loT Enterprise 2016 LTSB)¢"7
« Windows 8.1, Windows 8.1 (Pro, Enterprise) &7

0s 12374 « Windows 8, Windows 8 (Pro, Enterprise) %7
(Japanese/English) « Windows 7 (Professional, Ultimate, Enterprise) ®"
« Windows Vista® (Ultimate, Business, Enterprise)*8

- Windows XP°® (Professional SP3 or later)®

*1 When the following functions are used, this product may not run properly.
« Application start-up in Windows compatibility mode
« Fast user switching
* Remote desktop
* Windows XP Mode
« Windows Touch or Touch
« Tablet mode
« Virtual Desktops
*2 In the following cases, the screen of this product may not work properly.
« The size of the text and/or other items on the screen are changed to values other than default values (such as 96 DPI,
100%, and 9 pt).
*3 Log on as a user with the Administrator attribute when installing and uninstalling CW Workbench.
*4 TCP/IP is required.
*5 64-bit version only.
*6 The FTP server included in CW Workbench cannot be used.
For using the FTP server, use Microsoft Internet Information Services.
*7 The operating systems support CW Workbench with software version "F" or later.
Check the software version with the alphabet at end of the character string written in the DATE column of a DVD-ROM.
(Example: 1710AF indicate that the software version is "F".)
*8 32-bit version only.



2.4 Specifications

CHAPTER 2 SYSTEM CONFIGURATION

Below are specifications of CW Workbench.

Item

Specifications

Product name

CW Workbench

Operating system of applicable host
machine

Refer to "Operating environment"(_= Page 16, Section 2.3)

Applicable C Controller module

Refer to "Relevant Module".([__ 3 Page 16, Section 2.2)

Applicable operating system

Q24DHCCPU-V
VxWorks 6.8

Q24DHCCPU-VG

Q12DCCPU-V VxWorks 6.4

Framework

Wind River Workbench 3.2 base (Eclipse3.5)

Project creation and management

VxWorks Downloadable Kernel Module Project

Building

Q24DHCCPU-V
GNU compiler (GCC 4.1.2 for Intel Atom Z5xx)

Q24DHCCPU-VG

Q12DCCPU-V GNU compiler (GCC 3.4.4 for SH-4A)

Debugger

» Debugging execution restart

» Debugging execution forced stop

» Breakpoints

« Step through execution

« Variables/structure variables reference and editing
* Register value reference and editing

» Memory block reference and editing

« Target connection agent

» Dynamic Printf (Q24DHCCPU-V/-VG only)

License format

Node locked

Document

Wind River Workbench 3.2 Help document

17
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CHAPTER 3 PACKING LIST

3.1

Packing List

The following items are included with CW Workbench. Check that all the items are included before use.

(1) Items included with CW Workbench

Model name

Item

Qty.

(Product with license)
SW1DND-CWWLQ12-E
SW1DND-CWWLQ24-E

DVD-ROM([_ 5 Page 18, Section 3.1 (2))

"Before Using the Product”

License Certificate

End-User Software License Agreement

Permanent License Application Form (sample)

(Additional license product™)
SW1DND-CWWLQ12-EZ
SW1DND-CWWLQ24-EZ
(Updated license product )
SW1DND-CWWLQ12-EVZ
SW1DND-CWWLQ24-EVZ

"Before Using the Product”

License Certificate

End-User Software License Agreement

Permanent License Application Form (sample)

*1 The DVD-ROM is not included with the CW Workbench additional license product or updated license product. To install
CW Workbench, the DVD-ROM included with the CW Workbench product with license is required.

(2) Contents of CW Workbench DVD-ROM

Content Description Storage location
\
CW Workbench install image | An install image file of CW Workbench )
\images
Relevant manuals of VxWorks and Wind River Workbench 3.2 \docs

Relevant document

(PDF)

A license notice (PDF) of the third party used in CW Workbench

\3rd_party_licensor_notices

Manual CW Workbench Operating Manual (PDF) \manual
An application form for a permanent license and a license transfer.
Permanent License (PermanentLicenseApplicationForm.xls) \
Application Form Use the form when applying for a permanent license and a license
transfer.
Afile to be used as an install key when you do not have a
. permanent license file and do not have the Internet.
Install key file . . . \
CW Workbench operates with no license when having been
installed using an install key file (Install_SH_IA.txt).
CW Workbench )
A CW Workbench open source file \src

open source file

18



CHAPTER 3 PACKING LIST

3.2 Things to Prepare

The following lists things to prepare before using CW Workbench.

(1) Development environment (personal computer)

Prepare a personal computer to install and use CW Workbench.

Point/’

Enter the host name within 2 to 15 alphanumeric characters for a personal computer to be used as a development
environment (personal computer).
Operating Environment for operating specifications of a personal computer.(l__ s Page 16, Section 2.3)

(2) CW Workbench DVD-ROM
Prepare a CW Workbench DVD-ROM included with the product with license (SW1DND-CWWLQ12-E,

SW1DND-CWWLQ24-E).
The DVD-ROM is required to install CW Workbench. Apply for a permanent license using an application form

stored on the DVD-ROM.

(3) License Agreement
An LAC described in the License Agreement is required to install CW Workbench by using a temporary license.
An LAC and a product ID described in the License Agreement are also required to apply for a permanent license.
Prepare the License Agreement included with CW Workbench.

(4) Permanent license file

A permanent license file is required to install CW Workbench by using a permanent license.
To acquire a permanent license file, use a Permanent License Application Form stored on the DVD-ROM and

send us the Form.

aledaid 0} sbuiyy z'¢

(5) Internet connection
An Internet connection is required to install CW Workbench by using a permanent license.
Acquire a 31-day temporary license via the Internet.
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CHAPTER 4 PROCEDURE OVERVIEW

4.1 From Installation to Debugging

Obtain a permanent license.
Apply for a permanent license.

[ 5 Page 22, Section 5.1

Installation
How do you install the product?

A
| | |
[ 5 Page 27, Section 6.1

b Pege P e

Apply a permanent license.
Apply a permanent license that is sent later to the development
environment (personal computer).

[ 5 Page 25, Section 5.3

,
,
,
, Permanent License File: Yes Permanent License File: No Permanent License File: No
,
,
,
i
{

Use the permanent license file for Use the temporary license file for Use the install key file for
installation installation. installation. 1

Internet Connection: Yes Internet Connection: No 1

[ = Page 20, Section 4.1 (1) ) [ = Page 20, Section 4.1 (2) L [ = Page 20, Section 4.1 (3) '

J '

)

v
To the next page

(1) Installation using a permanent license

This installation is for users with a permanent license (regular license). All the functions of CW Workbench can be
used for unlimited duration.

(2) Installation using a temporary license

This installation is for users with a temporary license acquired on the Internet. All the functions of CW Workbench
can be used for 31 days after the installation.

(3) Installation using an install key on the DVD-ROM

This installation is for users having neither permanent license nor Internet connection.
Only the editor, import, and export functions of CW Workbench can be used. The build, compile, or debug
functions cannot be used.
Note that for SW1DND-CWWLQ24-EVZ, the installation using the following install key files cannot be executed.
* Install_SH4.txt of SW1DND-CWWLQ12-E
* Install_SH_IA.txt of SW1DND-CWWLQ24-E
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CHAPTER 4 PROCEDURE OVERVIEW

FLEXIm License Finder X

Your application was not able to obtain & licenss

The dialog box shown to the right appears when
CW Workbench is started up with no license. BE st e ey

needs. Please choose one of the following:

Click Cancel to continue the operation.

(%) Specify the License Server
() Specity the License File

Copyiight (6] 1858, 2003 Macrovision Corporation

From the previous page

!

Apply a patch.

Information and services
For further information and services, please consult your local Mitsubishi representative.

[~ 5 Page 54, CHAPTER 7

Create a project.
Create a user program project and perform programming.

[ = Page 57, CHAPTER 8

Build.
Build a user program.

[ 5 Page 71, Section 8.3

Connect the target.
Connect CW Workbench to the C Controller module.

[_5 Page 77, CHAPTER 9 )

Download.
Download the user program on the C Controller module.

Buibbngaq 0} uone|eisu| woi4 |’y

[ 5 Page 85, CHAPTER 10

Debug.
Debug the user program.

[ = Page 85, CHAPTER 10
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CHAPTER 5 PERMANENT LICENSE

5.1 Obtaining Permanent License

A permanent license is required to use CW Workbench for unlimited duration. Follow the instructions shown below to
obtain a permanent license.

Start obtaining a permanent license.

!

Obtain a Permanent License Application
Form on the DVD-ROM.

!

4 N\
Obtain host information on the development [ = Refer to the Permanent License Application Form (sample)
environment (personal computer) where included with the product for how to acquire host machine
CW Workbench is used. information.
o /
4 N\
) ) o [ = Refer to the Permanent License Application Form (sample)
Fill out the Permanent License Application included with the product for how to fill out the form.
Form. Directly enter information on the Application Form stored on
L ) the DVD-ROM (PermanentLicenseApplicationForm.xIs on
l the Permanent License Application Form).
4 N\
EN
Send the Application Form to the address | Lgl >
. L A
described on the form. MAIL L;I .
Permanent License —

\_ . Application Form Will be

replied
4 N within
5 working

A permanent license file will be e-mailed Permanent [#%¥% days
to you. — MAIL license file ’V:E
\ J = ==
4 N
Apply the permanent license file to the [~ 5 Page 25, Section 5.3
development environment (personal ’
computer).
. .
Completed.

*1 For the development environment (personal computer) information on the Permanent License Application Form for the
updated license product, enter the same information as the one registered to acquire the permanent license previously.
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CHAPTER 5 PERMANENT LICENSE

5.2 License Transfer

Another permanent license is required on a new development environment (personal computer) for license transfer
due to reasons such as when the development environment (personal computer) where CW Workbench has been
installed crashed.

Follow the instructions shown below for license transfer.

Start license transfer.

Has the
development environment
(personal computer)
crashed?

No

Yes .
Uninstall CW Workbench on the current [ Page 41, Section 6.2

development environment (personal
computer).

A

[ = Page 26, Section 5.4

Delete the current permanent license
file.

(Delete the permanent license file
saved as a backup file as well.)

l

Obtain a License Transfer Certification
Agreement Form on the DVD-ROM.

l

Obtain host information on the development For how to obtain host information, refer to

environment (personal computer) where . S
CW Workbench is used. Egzgslg?anent License Application Form

l

To the next page

Jajsuel) 8susol] Z'G
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From the previous page

[ Directly enter information on the License Transfer
Fill out the License Transfer Certification Certification Agreement Form stored on the DVD-ROM
Agreement Form. (PermanentLicenseApplicationForm.xls on the License
Transfer Certification Agreement Form).

Fax the License Transfer Certification FAX E

Agreement Form with your signature to
your local Mitsubishi service center or
representative where you purchased
License Transfer

the product.

|
|
|
|

Certification Agreement Will be
E replied
| within
E 5 working
™\ Permanent [ days
) ] ] ) P MAIL license file =
A permanent license file will be e-mailed = =
to you. = | &=
) =
~
Install CW Workbench on the new [ Page 27, Section 6.1
development environment (personal
computer) using the new permanent
license.
/

!

Completed

If you have lost the License Agreement and do no know the Product ID, contact your local Mitsubishi service center or
representative and give them information filled out on the Permanent License Application Form.

» Name of the representative person, department name, and company name

+ E-mail address

+ Target CPU



CHAPTER 5 PERMANENT LICENSE

5.3 Applying Permanent License

Apply the acquired permanent license file to the development environment (personal computer) specified for "Host
machineinformation" on the application form.
Follow the instructions shown below to apply the permanent license file.

Start applying a permanent license.

Yes

CW Workbench is running.

No
Terminate CW Workbench.
v
[ = Below is a license folder when CW Workbench is installed
on the C drive without changing the folder of the installation
Copy the obtained permanent license file location.
on the license folder of CW Workbench.™ C:\WindRiver\license

= | WindRiver
) ind F_F.-.f.

+ | ) docs
N =_
—1] jgnu License file
B (2 e
'} icenze

Note: Do not store the license file in folders other than the one
Start CW Workbench. specified above and use the file when applying the license
file to the development environment (personal computer).

Completed

9su99I Jusuewlad Bulflddy ¢'g

*1 When two or more permanent license files are obtained with the updated license product, overwrite all files.
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5.4 Deleting Permanent License

Follow the instructions shown below to delete the current permanent license for license transfer.

Start deleting the permanent license.

Yes
CW Workbench is running.
No
Terminate CW Workbench.
v
4 N
[ 5 Delete all the files in the license folder of CW Workbench.
Completely delete the permanent license C:\WindRiver\license
file from the license folder of CW
Workbench.
(Delete the permanent license file saved
as a backup file as well.) = _:I WindRiver
]
9 ) I wind _’j".,y'
'-Ij docs Recycle bin
L) BN s
: = License file
) Ire EJ
v
Completed
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

CHAPTER 6 INSTALLATION AND
UNINSTALLATION

6.1 Installation

This section explains how to install the product, how to operate, and precautions.

Unless operations differ depending on the operating system, windows and dialog boxes of Windows® XP are used for
explanations.

6.1.1 Preparation before installation

(1) Log on as a user with the Administrator attribute when installing the product
on the development environment (personal computer).

(2) Insert the DVD-ROM into the development environment (personal computer),
the installer automatically starts.

Point/’

For CW Workbench with the software version "F" or earlier, "Install.vbs" is not contained in a DVD-ROM. Run "setup.exe" to
install CW Workbench.
For details on the software version and supported operating systems, refer to the following section.

[T 5 Page 16

When a screen to play DVD automatically appears, select "Run wscript.exe"*1.

If the installer does not automatically start, double-click "Install.vbs" on the DVD-ROM to start it.

Do not execute more than one "Install.vbs" at the same time, or the product may not be properly installed. If the
installation was not completed properly, uninstall the product and execute "Install.vbs" again.

*1 For CW Workbench whose software version is "F" or earlier, "Run setup.exe" appears.

27

uone|jelsul aiojeq uoneledald |19

uopejesu| L9




(3) For installation on Windows Vista® or Windows*® 7 or later, a dialog box asking

whether to enable or disable User Account Control appears.
Click "Allow" or "Yes" to continue the installation.

+ For Windows Vista®
« Installed with "Install.vbs"

User Account Contral

Windows needs your permission to continue

If you started this action, continue,

i Microsoft (R) Windows Based Script Host
7 Microsoft Windows

User Account Control helps stop unauthorized changes to your computer.

« Installed with "setup.exe"

Click "Allow" or "Continue".
User Account Contral

‘-.ﬁ' An unidentified program wants access to your computer
v

Don't run the program unless you know where it's from or you've used it
before.

IE] setup.exe
Unidentified Publisher

* Cancel

Tdon't know where this program is from or what it's for.

< Allow

Ttrust this program. ] know where it's from or I've used it before.

(%) Details

User Account Control helps stop unauthorized changes to your computer.

 For Windows® 7 or later
« Installed with "Install.vbs"

%) User Account Control
;ﬁ Do you want to allow the following pro
%

changes to th

i Program name:  Microsoft ® Windows Based Seript Host
7 Verified publisher: Microsoft Windows

Change when these notifications appear

(%) Show detsils

Click the button.

Installed with "setup.exe"

| User Account Control

Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  setup.exe
Publisher: Unknown
File origin: CD/DVD drive

(%) Show details

Change when these notifications appear
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CHAPTER 6 INSTALLATION AND UNINSTALLATI

(4) Acquire a permanent license file.
If you require the Permanent License Application Form, or if you have purchased the updated license
product, please consult your local Mitsubishi representative.

Point/’

@ Stop all other applications running on Windows® before installation.

@ The installer may not operate the functions properly due to the automatic start of update programs of the operating

system or any other software, such as Windows® Update or Java Update. Change the setting to disable the automatic

start of update programs before installation.

® CW Workbench cannot be over-installed on the development environment (personal computer) where CW Workbench

has been already installed. Uninstall the product before reinstallation.

® Do not install the product on the development environment (personal computer) where Wind River Workbench has been
already installed. To install the product, uninstall Wind River Workbench or prepare another development environment

(personal computer).

® When the product is installed by using a temporary license, the product operates for 31 days. A regular license is issued

after a permanent license is obtained. Use the permanent license to start the product.

& Licensoiioh Found ) The license error message shown below appears after 31
@ TS (26 ey (B ey (AR Brestord) e (o etiom tie days. The product continues to operate by clicking the
Eone o B b RKRENCH C | i i ili
EiS??‘E’Eaateth 0“se0-2010 ance button, but the project creation, compiling/

A licensz filepath is descrived building, and debug functions cannot be used.
FLEXIm error: -10,32
B R A [License error message]
Error text: "Feature has expired
Error code: -10

® To install CW Workbench using a temporary license, it can be obtained via the Internet. Before installation, check that

personal computer can be connected to the Internet.
If the personal computer is connected to the Internet via a proxy server, check the IP address and port number in
advance. They are required to be set during installation.

® Note the following when installing the updated license product.

the

» Enter the LAC (License Authorization Code) written on the License Agreement of updated license product to LAC

on the User Information window.
» The updated license product (SW1DND-CWWLQ24-EVZ) cannot be installed with the install key file
(Install_SH4.txt) of the product with license (SW1DND-CWWLQ12-E).

29
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6.1.2 How to install CW Workbench

Start installing CW Workbench Insert the CW Workbench DVD-ROM into the DVD drive
C to start the installer.

1. After the installer is started, execute one of the

following operations and click the 0K |
button:

Browse..._| » Enter a folder name of the installation
location.

0k, Cancel
Q I * Click the  Browse.. | button to select a
folder of the installation location from the
tree view.

£ Wind River Installer

Select the Wind River install location:

Point/’

@® The following characters can be used for a folder name of the installation location: (Space cannot be used.)
» Alphanumeric characters
* Hyphen "-"
» Underscore "_

The product cannot be properly installed if characters other than those described above are used for a folder name.

@® The dialog box shown below may appear after the ok | button is clicked. Clicking the Cancel |

button does not cancel the operation.

£ Wind River Installer

PFieparing installer

[ ] ]

2. clickthe [  Mext > |button.

[B=ES)

WIND RIVER

Wilind River Installer for
Wind River 32 for ishi G G

<

To the next page
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® Installer—On-line Update Settines

Choose on-line update settings:
[Z]Ghesck arrline for Iatest updates for this installer
[Z]Gheck on-line for latest Wind River product updates

URL for update repositories
[mte:

com/oemdy

[[] Gonnect to internet using proxy server

Help < Back Next > Gancel

CHAPTER 6 INSTALLATION AND UNINSTALLATION

3. Clickthe [ Mext >

To update the installer or this product, select the checkboxes of
“Checkon-line for latest updates for this installer” and “Checkon-line
for latest Wind River product updates”. The latest installer or the
product is downloaded and updated.

J button.

Point/

If the personal computer is connected to the Internet via a proxy server, check the box of "Connect to internet using proxy
server" and configure the proxy server setting set for the Internet connection on the personal computer.

8 Installer—On-line Update Settines

CEIX

Ghoose on-line update settines:
[FCheck on-line for latest updates for this installer
[FICheck on-line for latest Wind River product updates

URL for update repositries
i

ot 6 igimet i piosy sever
Ghaose prasy server type:
Owieb Proxy  O'SOCKS Proxy

Enter URL information fo proxy cerver

P addess | part

ense Aereement

By selecting "1 AGGEPT the terms of this license aereement” and clicking Next, you consent to the
terms of this sgreement. I you do not wish to be bound by the terms of this sereement, click Gancel and
do rot install this softnare

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE WIND RIVER
PROPERTY AND PROTECTED BY UNITED STATES COPYRIGHT LAW AND
INTERNATIONAL ~ TREATY.  UNAUTHORIZED USE, REPRODUCTION OR
DISTRIBUTION IS SUBJECT TO CIVIL AND CRIMINAL PENALTIES.

BY CLICKING ON THE "I ACCEPT" BUTTON YOU ACKNOWLEDGE THAT YOU

HAVE ENTERED INTO AN AGREEMENT WITH MITSUBISHI ELECTRIC
CORPORATION RELATED TO YOUR USE OF THIS PRODUCT.

04April2010

@I ACGEPT the terme of this license agreement.
O1D0 NOT AGGEPT the terms of this license agresment

i Help [ < Bk J[ Hext » kﬂ Gancel |

1S4

To the next page

4. Select "I ACCEPT the terms of this license

agreement.” and click the [ Next > J button.
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5. To continue the installation, select one of the following procedures:
If the permanent license file is not obtained
« Installation using a temporary license (a personal computer can be connected to the Internet):
= (1)(2)(3) [ 7 Page 33
* Installation using an install key on the DVD-ROM (a personal computer cannot be connected to the Internet):
=> (4) [ 5 Page 35
If the permanent license file is obtained

* Installation using a permanent license
= (5)[L 7 Page 36
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

Installation using a temporary license
(1) Select "Temporary install key (requires an Internet

® Installer—Ghoose Activation Type

connection)” and click the | Mext > | button.

Ghoose Istall Ky Type:

© Use the existing product activation file.

© Temporary install key fequires an Intemet connection!

© Permarent install key file
Enter the full path 1o your install key file.

[ Browse.

O Manually enter all install keys
Click next to enter the install keys for sach product

[ b J[ <Bax J[ s, [ Gacel |

Point/

@ If "Temporary install key" is selected, the Internet is required to acquire "Temporary install key". Execute the installation
on a personal computer connected to the Internet.

@ If the personal computer is connected to the Internet via a proxy server, configure the proxy server setting. ((__= _ Page
31 Point)
If "Temporary install key" is selected without configuring the proxy server setting, installation does not proceed.

(2) Check the content of "Note" on the window. Select
either "Ethernet Adapter" or "Disk Serial Number" for

© Installer=Host Information

the Host ID and clickthe | Next > | button.

Please choase 2 host ID to identify the computer on which you are installing this saftnare.

Host Name: st

Selection | Host ID Type
0] S Eiternet Adapter
o) DISK_SERIAL NUM=heibaas Disk Serial Number

Note: host IDs are 3 ay {0 uniguely identify computers. If your computer has multiple network adapters
for example, wired and wireless), select your hard disk serial number as your host [0 instead

([ bem  J{ <k J[Hext> ([ cencel |

(3) Enter a License Authorization Code (LAC) and user
information listed below and click the

& Installer—User Information

[ Mext > J button.

Pleass enter your contast information and Lissnse Authorization Gode {LAG)
Mote: Required fislds are marked with an asterisk 04)

=LA [

*iser Hame |

*Company: | Mitsubishi Electric Gorporation

*Addresst: (114, Yada~minami 5-cho me, Higashi-ku

Address2

Gty [Nagoys

*State: [ichi

*Country: [ Japan

+Zip Code:  [461-8670
*E-mail [

*Phone: [+81-62-712-2278

[ e J <Bek  J[ s> [ Cacel
- Iy
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Point /S’

Use alphanumeric characters for the LAC and user information.
(Items with a * mark on the window must be entered correctly.)

License Authorization Code

LAC: (described in the License Agreement included with CW Workbench)
User Name: User name

Company: Company name

Address1: Address (such as town name and block number)
Address2: Building name, etc. (can be left blank)

City: City

State: State

Country: Country

Zip Code: Zip code

E-mail: E-mail address

Phone: Phone number

A8

Go to the step 6 ((_7 Page 37)



CHAPTER 6 INSTALLATION AND UNINSTALLATION

Installation using an install key on the DVD-ROM

(4) Select "Permanent install key file", click the

button, specify the following install key file stored on the

DVD-ROM, and click the | Next > | button.
2> For Q24DHCCPU-V/-VG: "Install_SH_IA.txt"
e 2> For Q12DCCPU-V: "Install_SH4.txt"
[ hee J[ <Baek ][ Mexwkv][ Cencel

Point/’

When the installation is executed with specifying the install key file, CW Workbench is installed without license and only the
following functions can be used:

« Editor function (such as creation, editing, saving, and searching)

* Import/Export
To use all the functions of CW Workbench, obtain and apply a permanent license.

[ 5~ Page 22, Section 5.1
[ 5~ Page 25, Section 5.3

<~

Go to the step 6 ((_7 Page 37)

uopejesu| L9
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Installation using a permanent license

@ Installer-Choose Activation Type

O Temperary install key (requires an Internet connection)

® permanent install ke fils

Bramse

O Manualy enter al insall keys
Click next to enter the install keys For each product

(b J[ <o J[ tewr J[ o ]

(5) Select "Permanent install key file" and click the

button.

Select the permanent license of the product to be
installed from the tree view. Then click the

[ Mext > ] button.

1S4

Go to the step 6 ((_7 Page 37)
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® Installer-Choose Installation Filters

Target Architectures:

It Ge B iore Targel 3
fre uncertain, you may select all of them

TG pracesEGrE You plan ta S B your tarest I Yol ]

Ontel Select all
[SuperH

Deselect al

C e ][

< Back

J[ we > [

Gancel |

@ Installer—Select and Install Products

Products and Features

[ [7] ] Wind River Workbench 32 for Mitsubishi G Gortrallers

Installation Directory
CwindRiver

Disk Space Information
Tatal Disk Space Required
Disk Space Available

127 GB
2817 GB

Help < Back nstall Gancel

® Installer—Select and Install Products

=]

<

Z
w

=

Products and Features

& | Wind River Warkbench 32 far Mitsubishi C Controllers
@ i Wallorks 847 Application Developer

&G Wind River Setup 201

E-6ji Wind River Vorkbench Core 3203

&6k Wind River GNU Gompiler 344 for ViWorks 84 (modified for Windows Vista and Windows 7)

Bk Wind River Workbench 32 for Vsorks 68 {(Enabler Rev 3)

Installation Directory
CwindRiver

Disk Space Information
Tatal Disk Space Required
Disk Space Available

Installation Proeress
Installation Complete

127 GB
228m GB

< Back

Gancel

<

To the next page

CHAPTER 6 INSTALLATION AND UNINSTALLATION

6. Click the | Dezelect all | button.

Select the following items, and click the

[ Mext > J button.

2> For Q24DHCCPU-V/-VG: "Intel"
=> For Q12DCCPU-V: "SuperH"

Check that "Wind River Workbench 3.2 for
Mitsubishi C Controllers™ has been selected.

Click the [

Inztall | button.

If the check box is [&] or [ ], keep clicking the box

until it changes to [=].

8. Click the | Next > | button.
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Useful “readme” information is provided below:
4
|
Help | < Back |[ Next > ] ( Cancs|

inish Installation

Thark you for installing Wind River Workbench 3.2 for Mitsubishi C Controllers
Please select the configuration tasks you would like the installer to perform.

@ [2[# Deskiop Shortouts
Start Menu Entries

Help < Back [ Ersn ] Gancel

<

Completed

38
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Mext >

J button.

10. Click the (

Einizh

J button.




CHAPTER 6 INSTALLATION AND UNINSTALLATION

6.1 .3 After installation

This section explains an icon registration, sample programs, and a patch application after the product is installed.

(1) How to start CW Workbench

After the product is installed, [Wind River] is added on Windows® Start’!, and the following menus can be
selected.
Start the product from "CW Workbench" in the "CW Workbench" menu.

*1 Select [All apps] on the Start screen or [Start] => [All Programs]/[All apps].

Menu Description
CW Workbench Starts CW Workbench.
Starts Wind River Registry for Workbench 3.2.
[CW Workbench]*3 Redistry' When CW Workbench is started, Wind River Registry for Workbench 3.2
egistry also starts, except when it is running already. An icon is registered on the
task tray.
. Workbench 3.2 Wind River Workbench 3.2 document
[Documentation] 3 "
VxWorks 6.8 VxWorks 6.8 document

Uninstalls and updates CW Workbench and applies a patch.

i "3 Installation at X YYYY
[Product Maintenance] (X: drive name, Y: folder name of the installation location)
Starts WFTPD.
FTP Server? For available operating systems, refer to the following section.
[VxWorks 6.8.1 Application [ Page 16, Section 2.3
Developer]*“3 or Starts HyperTerminal for Telnet connection.
[VxWorks 6.4.1 . VxWorks COMx cannot be used on the operating system, such as
. w3 | VXWorks COMX™* . . _ . o IR
Application Developer] < Windows Vista and Windows 7 or later, where HyperTerminal is not P
installed. > ,g,
FE
VxWorks Development Shell™ Starts a command line Shell in which the Gnu compiler can be used. c‘_E, o
> 0o
Q5
*1: For SW1DND-CWWLQ24-E ;:’
*2: For SW1DND-CWWLQ12-E =4
=}

*3: Does not appear in Windows® 8 or later.
*4: When CW Workbench is installed on a personal computer runnning Windows® 8 or later, the names of the menus are
changed depending on the version of VxWorks.

VxWorks 6.4 VxWorks 6.8
FTP Server,6.4 FTP Server,6.8
VxWorks COMx,6.4 VxWorks COMx,6.8
VxWorks Development Shell,6.4 VxWorks Development Shell,6.8

*5: When CW Workbench is installed on a personal computer runnning Windows® 8 or later, the names of the menus are
changed depending on the version of Wind River Registry for Workbench.
For Wind River Registry for Workbench 3.2: Registry,3.2
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(a) Sample programs to be registered
Sample programs provided by Wind River Systems, Inc. are installed when the product is installed on the
development environment (personal computer). To check the sample programs to be installed, start the product
and select from the file menu [New] => [Example...].
For details on the sample programs, refer to the Wind River Workbench document provided by Wind River
Systems, Inc.

O [Helplin the menu bar=>[Help Contents]=>"Wind River Documentation" — "Guides" — "Host
Tools" — "Wind River Workbench By Example(VxWorks 6 Version), 3.2"
If the SW4PVC-CCPU or SW3PVC-CCPU has been already installed on the development environment
(personal computer), the sample programs for the C Controller module can be imported to the product and
used.



CHAPTER 6 INSTALLATION AND UNINSTALLATION

6.2 Uninstallation

This section explains how to uninstall CW Workbench and precautions.

Unless operations differ depending on the operating system, windows and dialog boxes of Windows® XP are used for
explanations.

6.2.1 Preparation before uninstallation

(1) Log on as a user with the Administrator attribute when uninstalling the product
on the development environment (personal computer).

(2) Terminate the product before uninstallation.

(3) Uninstall the product in [Product Maintenancel].
The product cannot be uninstalled from "Add or Remove Programs" in the Control Panel.
[Product Maintenance] can be executed as follows: [Wind River] &> [Product Maintenance]*2 o> [Installation at X
YYYY] from Windows® Start !
*1 Select [All apps] on the Start screen or [Start] => [All Programs]/[All apps].

*2 Does not appear in Windows® 8 or later.

X and YYYY of [Installation at X YYYY] mean as below:

X: The drive to which the product has been installed

YYYY: The folder to which the product has been installed
If the folder of the installation location selected upon installation is C:\WindRiver, the menu name is [Installation at C
WindRiver].

(4) Do not stop the processing during uninstallation. If the processing has been
stopped, uninstall the product again.

If the uninstallation processing has failed after the uninstallation processing has been stopped, reinstall the
product. Then uninstall the product again.

41
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(5) For uninstallation on Windows Vista® or Windows* 7 or later, a dialog box
asking whether to enable or disable User Account Control appears.

Click "Allow" or "Yes" to continue the uninstallation.

+ For Windows Vista®

User Account Cantrol =5

‘-\ﬁ' An unidentified program wants access to your computer
=

Den't run the program unless you know where it's from or you've used it
before.

Iﬂ witlnstaller exe
Unidentified Publisher

% Cancel
Tdon't know where this program is from or what it's for.

Click "Allow".

i % Allow
Ttrust this program. I know where it's from or I've used it before.

(%) Details

User Account Control helps stop unautharized changes to your computer.

« For Windows® 7 or later

%! User Account Control (==

@ Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  wrlnstaller exe H
Publisher: Unknown Click the button.

File origin: CD/DVD drive

(%) Show detsils

Change when these notifications appear




622 How to uninstall CW Workbench

CHAPTER 6 INSTALLATION AND UNINSTALLATION

1.

2.

Start uninstalling CW Workbench

284

If the "Wind River Registry for Workbench 3.2" icon

( 'ﬂr ) exists on the task tray of Windows®, select
"Shutdown" in the menu that pops up by right-
clicking the '@ icon.

Click after the following dialog box appears

to terminate "Wind River Registry for Workbench
3.2",

Do vou really want to shutdown the Wind River Registry 7
LY

!

iou will not be able to start any new Wind River tools or target servers

| Yes | [ Mo

284

Select one of the following procedures:
* When a patch has been applied
=> (1)(2)(3)(4) 7 Page 44
* When a patch has not been applied
2> (3)(4) [ 7 Page 45

43
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~ — f— (1) Select [Start]=>[All Programs]=>[Wind
O Workbenc
[E) Documentation . River]=>[Product Maintenance]=>[Installation at X

i Product 2 [ YYYY]. In the menu that pops up by right-clicking,
@ Wworks 6.4, 1 Application Developer select "Proper'ties".

« For Windows® 8 or later
Select [Wind River] <> [Installation at C Windriver] from
Windows® Start™". In the menu that pops up by right-
clicking, select "Open file location".
Select Installation at C Windriver from the shortcut. In the
menu that pops up by right-clicking, select "Properties”.

*1 Select [All apps] on the Start screen or [Start] => [All
Programs]/[All apps].

(2) Atthe end of the "Target" field on the <<Shortcut>> tab,

Installation at € WindRiver Properties add the following argument, then click the
General | Shortcut | Compatibility || Security| Ok | button.
_ o [Argument] -vmargs -Dallow_patch_removal=true
IQ Inztallation at C WwWindRiver

Target tppe: Application

Target lozation: 226-win32

Target: |Installer.e>: -vargs -Dallow patch removal=tru

Start in; |E:MindF!iven’maintenancef’wrlnstaller#HSE-winBZ

Shortcut key: |None |

Run: | Marmal window A |

Cormment: | |

[ Find Target... ] [ Change lcon. . ] [ Advanced... ]

L aF. ][ Cancel ][ Apply

Point/’

When a patch has been applied and uninstallation is executed without the argument, the [Wind River] => [Product

Maintenance]=> [Installation at X YYYY] menu is not uninstalled and remains.
Uninstalling CW Workbench following the steps described earlier can delete the remaining menu.

1S4

To the next page
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

. (3) Select [Wind River]=>[Product
CW Wiorkbench
) Decureriation Maintenance]*2-:> [Installation at X YYYY] from

i Product Maintenance ®  Installation at G WindRiver

fili Wind River 3 15 iiitarks 641 Application Develaper Wil’]dOWS® Start*1 .

*1 Select [All apps] on the Start screen or [Start] => [All
Programs]/[All apps].

*2 Does not appear in Windows® 8 or later.

—— (4) Select "Remove" and click the[ Mext > ]

® Installer-Chooss Installation Type

WIND RIVER button.

O Product Updates

F Download and apply updates for entitled product
F Hpply Patches, individual fixes for individual problems.

©@Remove:

@ Remave parts or all installed features.

284

Go to the step 3 ([_7 Page 46)
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& Installer-Remoye Details [M{[=1E3]

@ Select features to uninstall

@ [ Wind River Workbench 32 for VaWorks 6.8 (Enabler Rev 3)

 \iorks 641 Application Developer

(5 Wind River GNU Gompiler 344 for Viorks 6.4 {modified for Windows Vists and Windows 7)
L Wind River Setup 201

L Wind River Workbench Gore 3203

Help < Back Femove Gancel

3. Check that items to be uninstalled have been

selected.
Click the button to start the
uninstallation.

Point/’

If the argument to uninstall the patch has been added in the step 2 (2), select all the items, not only the patch, for

uninstallation.

Note that uninstalling only the patch may lead to improper operation.

® Installer-Remove Details

@ Uninstall completed

@k Wind River iarkbench 32 far Wliorks B8 (Enabler Rev 3

L Wiorks 4.1 Application Developer

gk Wind River GNU Gompiler 344 for VaeWorks 64 (modified for Windows Vista and Windons 7)
Lk \ind River Setup 201

@ [F]4 Wind River Workbench Gore 3203

e[ < Bask Finish [ Carcel |

284

Completed

46

= 4. Clickthe | Finish | putton.




CHAPTER 6 INSTALLATION AND UNINSTALLATION

6.2.3 After uninstallation

After uninstalling CW Workbench, some menus, folders, or files may remains in the Start menu or installation folder.

(1) Data not to be deleted
The remaining files and files are left to speed up the start-up of the installer when the product is installed again.
There is no problem even if the remaining folders and files are directly deleted from Explorer if they are not
necessary.

+ Data not to be deleted
Some files including Workspace folders and image files in <Folder of the installation location>.

After uninstallation, a deletion error dialog box shown below may appear when a folder of the installation location is deleted.

Click the k. button. Restart the development environment (personal computer) and delete the folder of the
installation location again.

Error, Deleting File or Folder

@ Cannat delete libwpwr4l: Access is denied.
Make sure the disk is nat full or write-protected

and that the file is not currently in use,

(2) Menus that remain

The following menus remain when CW Workbench is installed on a personal computer runnning Windows" 8 or § §

later. z2
« [FTP Server,6.4)/[FTP Server,6.8] g §
* [VxWorks COMXx,6.4]/[VxWorks COMx,6.8] g %
* [VxWorks Development Shell,6.4]/[VxWorks Development Shell,6.8] o) >
- [Registry,3.2] §'

For the menus registered at installation, refer to the following section.

[ 5 Page 39

By following the procedure below, delete the shortcut in the installation folder.
1. Select the menu to be deleted from [Wind River] from Windows*® Start™!, and select "Open file

location” in the menu that pops up by right-clicking.
*1: Select [All apps] on the Start screen or [Start][All Programs]/[All apps].

2. Delete the shortcut menu.
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6.3 Update

This section explains how to install the updated license product (SW1DND-CWWLQ24-EVZ), how to operate, and
precautions.

Unless operations differ depending on the operating system, windows and dialog boxes of Windows” XP are used for
explanations.

6.3.1 How to update CW Workbench

Start installing CW Workbench Insert the CW Workbench (SW1DND-CWWLQ12-E)
DVD-ROM into the DVD drive to start the installer.

1. Atfter the installer is started, execute one of the
® Wind River Installer

following operations, and click the Ok |
button:

Brovse... | * Enter a folder name of the installation location.

’—WIDK Cancel | * Clickthe _ Bmws=.. | button to select a folder

of the installation location from the tree view.

Select the ‘wWind River install location:

Point/’

@ The following characters can be used for a folder name of the installation location:
» Alphanumeric characters (space cannot be used.)
* Hyphen "-"
» Underscore "
The product cannot be properly installed if characters other than those described above are used for a folder name.

@® The dialog box shown below may appear after the 0k | button is clicked, however, clicking the

Cancel I button does not cancel the operation.

& Wind River Installer

Preparing installer

[ ] ]

2. clickthe [ MHext > button.

‘WIND RIVER

e staler for
Wind River Workbench 9.2 for Mitsubishi G Controllers

C ) oo ([ tew> J( omn ]
25

To the next page
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

3. Click the | Hext > | button.

@ Installer—On-line Update Settines

Ghoose on-line update settings:

[ Check on-line for latest updates for this installer
[F]Check on=line for latest Wind River product updates.

URL for update repositories
[rete ‘aem/mitsubishi,

[CGonnet ta internst using proxy server

[ tep J[ <Bsek  J[ Het 5 TJ[ Gancel |

Point/

If the personal computer is connected to the Internet via a proxy server, check the box of "Connect to internet using proxy
server" and configure the proxy server setting set for the Internet connection on the personal computer.

[FGheck orr-lne for Itest Wing River procuct updstes

URL for updste repositoies

odatezrenos

rver tpe:
b Praxy  ©SOCKS Praxy

Enter URL nformation forprosy server
P addess [ ] ot [

[ ee [ <@ J[ > [ G ]

sjepdn ¢9

4. Select "I ACCEPT the terms of this license

agreement.” and click the [ Next > J button.

By selecting “1 AGGEPT the terms of this licsnse agreement” and clicking Next, you consent to the
terms of this agreement. If you do not wish 10 be bound by the terms of this agresment, click Ganeel and
do not install this sottnare,

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE WIND RIVER
PROPERTY AND PROTECTED BY UNITED STATES COPYRIGHT LAW AND
INTERNATIONAL  TREATY. UNAUTHORIZED USE, REPRODUCTION OR
DISTRIBUTION IS SUBJECT TO CIVIL AND CRIMINAL PENALTIES.

4OUSQHOM MO o1epdn 0} MOH €9

BY CLICKING ON THE "I ACCEPT" BUTTON YOU ACKNOWLEDGE THAT YOU
HAVE ENTERED INTO AN AGREEMENT WITH MITSUBISHI ELECTRIC
'CORPORATION RELATED TO YOUR USE OF THIS PRODUCT.

04April2010

@TACOEPT the terms of this license agreement.
©1D0 NOT ASCEPT the terms of this license agreement

L Help < Back Hext > Cancel

1S4

To the next page
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5. To continue the installation, select one of the following procedures:

If the permanent license file is not obtained

* Installation using a temporary license (a personal computer can be connected to the Internet)
It is the same installation procedure as the one for temporary license using product with license.
([ Page 33)
Enter the LAC (License Authorization Code) written on the License Agreement of updated license product to
LAC on the User Information window.

* Installation using an install key on the DVD-ROM (a personal computer cannot be connected to the Internet)
Note that the installation using the following install key files cannot be executed.
* Install_SH_IA.txt of SW1DND-CWWLQ24-E
* Install_SH4.txt of SW1DND-CWWLQ12-E

If the permanent license file is obtained

Select "Permanent install key file" and click the

button.

Select the permanent license file from the tree view. Then

© Use the existine product activation fike.

tall key Gequires an Internet connection CI |Ck the [ HExt > button .

O Temporar

O Manuslly enter all install keys
ik next 1o enter the install keys for each praduct,

28

Go to the step 6 ([_= Page 51)
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

6. select the following items, and click the

£ Installer-Choose Installation Filters:

[ Mext > J button.

Target Architectures:

EIEEE e o Wore (arget archiEciues, 6 processors you plan 10 lise on your taret 1 you

areu;&nam ou.may. select all.of them, I:> For QZ4DHCCPU_V/_VG "lntelll
= For Q12DCCPU-V: "SuperH"

[ B J[ <Back  J[ BNetx> J[ gencel |

<

€ Installer-Select and Install Products [A[=E3

7. Check that "Wind River Workbench 3.2 for
Mitsubishi C Controllers™ has been selected.

Clickthe | [Install | button.

Products and Features
& [2] 9] Wind River Workbench 3.2 for Mitsubishi G Centrollers

If the check box is [&] or [ ], keep clicking the box

until it changes to [+].

Installation Directory
CabindRiver

Disk Space Information
Total Disk Space Required 127 GB
Disk Space Availeble 2817 GB

Hel < Bock [l [ Gareel
( b J Kr[ J

284

& Installer—Select and Install Products EH§”X|

sjepdn ¢9

8. cClickthe [  Mext > | button.

Products and Features
& 9l Wind Fuver Warkbench 52 for Mitsubishi © Gantrollers
-4 Vlhiorks 641 Application Developer
-£g% Urind River GNU Gompiler 3.44 for cWorks 64 {modified for Windows Vista and Windows 7)
L Wind River Setup 201
Lg% Uind River Workbench 32 for WWorks 65 (Enabler Rev 31
- Wind River Workbench Core 3203

4OUSQHOM MO o1epdn 0} MOH €9

Installation Directory
G¥WindRiver
Disk Space Information
Total Disk Spacs Requied 127 GB
Disk Space Available 2801 GB
Installation Progress
Installation Complete.

284

To the next page
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Useful “readme” information is provided below:

[ Heb  J| < Back [ BNe> J[ Gocel

h Installation

Thark vou for installing Wind River Workbench 32 for Mitsubishi G Gontrollers

Please select the configuration tasks you would like the installer to perform.

@ [2][#] Deskiop Shortouts
Start Menu Entries

Help Bacl | Enist | Qanee|
[ Hel J[ < Back ] FhLF[O\]

284

Completed

52

9. Click the (

Mext >

J button.

10. Click the (

Einizh

J button.




6.3.2 After update

CHAPTER 6 INSTALLATION AND UNINSTALLATION

This section explains an icon registration, sample programs, and a patch application after the product is installed with
the updated license product (SW1DND-CWWLQ24-EVZ).

(1) How to start CW Workbench

After the product is installed, [Wind River] is added on Windows® Start™, and the following menus can be

selected.

Start the product from "CW Workbench" in the "CW Workbench" menu.
*1 Select [All apps] on the Start screen or [Start] => [All Programs]/[All apps].

Menu Description

Product Mai - Installation at X YYYY Uninstalls and updates CW Workbench and applies a patch.
[Product Maintenance] (X: drive name, Y: folder name of the installation location)

CW Workbench Starts CW Workbench.

Starts Wind River Registry for Workbench 3.2.

[CW Workbench]! . When CW Workbench is started, Wind River Registry for Workbench 3.2

Registry™

egistry

also starts, except when it is running already. An icon is registered on the

task tray.

Workbench 3.2""

Wind River Workbench 3.2 document

[Documentation]*1 "
VxWorks 6.8

VxWorks 6.8 document

FTP Server 2

Starts WFTPD.
For available operating systems, refer to the following section.

[ 7 Page 16, Section 2.3

[VxWorks 6.8.1 Application

Developer]*1 .
VxWorks COMx 2

Starts HyperTerminal for Telnet connection.
VxWorks COMx cannot be used on the operating system, such as

Windows Vista® and Windows®7 or later, where HyperTerminal is not
installed.

VxWorks Development Shell 2

Starts a command line Shell in which the Gnu compiler can be used.

*1: Does not appear in Windows® 8 or later.

*2: When CW Workbench is installed on a personal computer runnning Windows® 8 or later, the names of the menus are

changed depending on the version of VxWorks.

VxWorks 6.4

VxWorks 6.8

FTP Server,6.4

FTP Server,6.8

VxWorks COMx,6.4

VxWorks COMx,6.8

VxWorks Development Shell,6.4

VxWorks Development Shell,6.8

*3: When CW Workbench is installed on a personal computer runnning Windows® 8 or later, the names of the menus are
changed depending on the version of Wind River Registry for Workbench.
For Wind River Registry for Workbench 3.2: Registry,3.2

53
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CHAPTER 7 APPLYING PATCH

This section explains how to apply a patch in case it is released in the future.

Unless operations differ depending on the operating system, windows and dialog boxes of Windows® XP are used for

explanations.

Point/’

® Log on as a user with the Administrator attribute when applying a patch to the product on the development environment
(personal computer).

@ Terminate the product before applying a patch.

® Apply a patch in [Product Maintenance].
[Product Maintenance] can be executed as following: [Wind River] => [Product Ma\intenance]*2 > [Installation at X

YYYY] from Windows® Start™!
* Xand YYYY of [Installation at X YYYY] mean:
X: The drive to which the product has been installed
YYYY: The folder to which the product has been installed
If the folder of the installation location specified at the time of installation is C:\WindRiver, the menu name is

[Installation at C WindRiver].

® Do not stop the processing during patch application.
Apply the patch again if the processing has been stopped.

@® When a patch is applied on Windows Vista® or Windows® 7 or later, a dialog box appears to enable or disable User
Account Control. Click "Allow" or "Yes" to continue the application of the patch.

« For Windows Vista®

User Account Control @

|4 An unidentified program wants access to your computer
L

Don't run the program unless you know where it's from or you've used it
before.

\E‘ wrinstaller exe
Unidentified Publisher

; " "
+ Cancel Click "Allow".
Idon't know where this program is from or what it's for.
< Allow
Ttrust this program. I know where it's from or I've used it before.
() Details
User Account Control helps stop unauthorized changes to your computer.
. ®
+ For Windows " 7 or later
%] User Account Control (=)
I@ Do you want to allow the following program from an
unknown publisher to make changes to this computer?
Program name:  wrinstaller.exe B
Publisher: Unknown Click the button.
File crigin: CD/DVD drive
) Show details Yes
Change when these notifications appear

*1 Select [All apps] on the Start screen or [Start] => [All Programs]/[All apps].

*2 Does not appear in Windows" 8 or later.
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CHAPTER 7 APPLYING PATCH

7.1 How to Obtain Patch

(1) Download a patch file from the site described below.

[ = Information and services
For further information and services, please consult your local Mitsubishi representative.

(2) Extract the downloaded file and store it in the updates folder in the folder of the
installation location of CW Workbench.

El When the installation location of CW Workbench is C:\WindRiver, the storage location of the patch is
C:\WindRiver\updates.

7.2 How to Apply Patch

Select [Wind River] => [Product Maintenance]*2 >

I G Warkbench

) Decurentation [Installation at X YYYY] from Windows® Start ™.

fil Product h -
S— *1 Select [All apps] on the Start screen or [Start] &>
[All Programs]/[All apps].

*2 Does not appear in Windows" 8 or later.

2. Select "Patch” and click the [ Mewxt

€ Installer-Choose Installation Type

~
WIND RIVER button. EN

I

Q

O Product Updates E
- -

ﬁ ) Download and apply updates for entitled praduct (e}
~ 9
©Patch E_;
) ]

F ipply Patehes, individual fixes for individual problems. o

< QO
g

) Remove >0

@ Remave parts or all installed features.

@

To the next page

95



—— 3. Check that the patch to be installed has been

[ [=1E3

& Installer—Install Updates

selected.

Click the | Thetall | button.

Install Directory Disk Space
GifindRiver 11059 KB / 2745 GB
Install Progress
Installation has nat started

Overall Installation Progress (installed 0 of 0 selected patches)

[ ]
Help < Back Irstall Cancel

Point/

If the patch to be installed is not displayed, check whether the storage location of the patch file is correct.
+ Patch file storage location
<Install folder>\updates

1S4

) 4+ Clickthe [ Finish ] button.

; Sposty o udato ssrce

<[] GW Workbench Patch Mitsubishi leon for Windows (11059 KB

Install Directory Disk Space
CHfindRiver 11059 KB / 2745 GB

Install Progress
Installed selected updates successfully

Overall Instal

Progress (installed 1 of 1 selected patches)

Completed
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CHAPTER 8 CREATING AND BUILDING USER PROGRAM

CHAPTER 8 CREATING AND BUILDING USER
PROGRAM

The layout of CW Workbench is shown below.

Menu bar Toolbar

% Device Debug — UserProject/UserProject.c - CW Workbench
lgne Edit Source Refactor  Mavigats Search Project  Target Run  Window Help l

B - BT B0 W e EE g @ IR | £ 2 Advanced De. [[
[ Project Explarer 27 % Debug Symbol Browser = O | [ UserProjecte 57 = O % Debug 32 =0
= - g #include <VxWorks.h> -~ =
=2 b” UzerPraject Oifind River YWeWarks 6.4 Downloadable Kernel *?ncluele <stdio.h> = i
B Build Tareets (SHT#50eruls - debue) f#include <string.h> "Debug"
5 Wind River Launches #include <stdlib.h> & ebug
: #include <taskLib.h>
4 Binaries N .
5 b finolude <cickli window
2= SHTTED " . " *%ncluele «ayaLib R . "
o emywr|]  "Project Explorer #include <time.n Editor
l.c] UserProf . . .
window #include "ObfFum window foodl =
#include "NdFunc 2 w 9 Breskpoints =0
=i =S
"Breakpoints" -
#define MAX_DEV MO [31) Jr BATNAAES = P
/= window
< | S gfedeba
= = 0111001
1 Remate Systems 53 =g N
-
2 & = £ ow %
. £k 3 H |5 09= Varisble |31} Register |6 Express | [ Memary 32 = O
=-E¥ Local
Build Console 52 €] Error Log | = Properties =4 =

i Wind River Reeistries

*3, Local Files o5 - | B |4 EEE ¥
= -
% Local Shells WOTKINE DIFECTory. U1/ USErs_ws W3 2/ CHW_HOW 107 USSTFIOJECT/ SH T FOUENUIE
B oorksfx 19216883 (ind River ‘oiorks £4) Ir?a[ked reLnSoau:lgrngt:Er%et]s and objects of T/user/ WS/nb3 2/ cnm_HonTos User Project/SH 750en ™ "Variables" window
| ther
if [-d" UserPro]ecpartla\ ee”; rm -rf Debue; fi " . " .
" " if [1 ~d " "dirmame “LlserPr e " roject/EntryWD Tint o™ ™ 1 1 Registers" window
Remote Systems I:;Il[l'dléls gseerjﬁctJ;a Bu||d Console o]ech;ﬁnlr');wD'l'Int‘ 1o
= irname * LzerPr toject/ser Project 0 1l " A " ;
: d bulldlng UseerJectJ)a o]ecl/UserFro]ectn ExpreSS|0ns WlndOW
window if [1-d ""dirname * LserPr rtla\Imagen I then mkdi "™ B " wind
bulldlng UserProject_p: tiall
if [ “dirname "UserProJect/Debug/UserProjectout 1 then mkdir -p dlmame UserPre emory rowser: window
bul ine UserProject/Debue/UserProject.out
make: built targets of C/user/’ WS b3 2w How Ta/User Project/SHT760enule
Build Finished in Project ‘UserProject  2010-08-26 09:15:06 ({Elapsed Time: IJ—

< | 3

P s AE B : o0Mof 43M [ ©

The layout of each window can be changed by dragging with the mouse. The layout shown above is the default layout.
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8.1 Creating Project

(1) How to create a project

1. TostartCw Workbench, select [Wind River] => [CW

Workbench]*2 &> [CW Workbench] from Windows®
Start™.

*1 Select [All apps] on the Start screen or [Start] =>
[All Programs]/[All apps].

*2 Does not appear in Windows® 8 or later.

s Workspace Launcher |

Enter a folder of storage location of workspace for

Select a workspace "Workspace:".(A folder can be also selected from
W Workbench stores your projects in a Folder called a workspace,
“hoose & workspace folder o use For this session, the tree VieW by clicking the BTDWSE... | button')
wiorks| B ¥ || B - .
epae Leone., | Clicking the ak. | button starts CW
Mote: The workspace directary must be writable,
and should be located on Fast {lacal) storage. Wo rkbench

[[]Use this as the default and dao nok ask again

A message box shown below may appear. Click the 0k | button.
& Warnine E‘

1 Wind River Rezistry created a new datak?ase at
=)

C:/WindRiver/wind/wtsreed hostname '

I wou have been uzing Wind River Waorkbench before, and wou want ta
migrate vour ald target connections, p\ealse quit Warkbench gnd the
Regigtry now, zearch for the file named 'wioreegd. hostname' in your old
inztallation and copy it 1o the new location,

Far detailz, zee the Online Help.

[] Do not show again

@

3. Select from the menu bar [File] => [New] => [Wind

‘s Basic Device Development — - CW Workbench
Edit Source Refactor Mavieate Search Project Bun  Window Help River Workbench ProjeCt"']'

Alt+Shift+N - W g Wind
Open File,. % Project..

284

To the next page
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s Hew Wind River Workbench Project

Target Operating System
Select the tareet operating zyatem for the project.

@ < Back i

Cancel

1S4

\s Hew Wind River Workbench Project

Build Type
Select the build type for the project.

Build tvpe: | Downloadable Kernel Module

oadal £
L 3| Time Procesz App
Description: |Relinkable Kernel Module
Shared Uzer Library
Static Kernel Library
Static Uger Library

Idzer-Defined
Tiore:

Setup information
Fesulting project type: Downloadable Kernel Module Project
Idzed build taol: Linker

@ [ <Back [ Mext> Finizh
0

Gancel

<

To the next page

CHAPTER 8 CREATING AND BUILDING USER PROGRAM

4. select the following item for "Target operating

system:". Click the button.

2> For Q24DHCCPU-V/-VG:
"Wind River VxWorks 6.8"

2> For Q12DCCPU-V:
"Wind River VxWorks 6.4"

5. Select "Downloadable Kernel Module" for Build

type:". Click the [ Mext > button.

59
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e 6. Entera project name for "Project name:" and click
s Hew Wind River Workbench Project =

Project . _ the [ Einish button.

Greate & new project with the specified data. B "UserProject" has been entered here as an example

Project name: | IESasie = |

Location

(%) Create project in workspace

(O Create project at external location

() Create project in workspace with content at external location

Directary: |CH¥WindRiver¥workspace¥UserProject Browse...

@ Mext » Finizh '\g [ Cancel
Ly
Point/

If characters that cannot be used or a project name that is already used are entered for "Project name:", an error text
appears on the header of the window and the [ Einizh

] button becomes disabled.
« If space is included in the "Project name:", the following error message appears.

& New Wind River Workbench Project

Project

@ ' is an invalid character in project name ‘User Project’ @

Project name: |18

Location
(®) Create project in workspace

(O Create project at external location

(O Create project in workspace with content at external location

Direstory: [ ¥WindRiver¥workspace¥lser Froject

Browse.
@

« If a project name that is already used is entered for "Project name:", the following error message appears.

& New Wind River Workbench Project

Project

@ * project with that name aheady exists in the workspace

Project name:

Location
(®) Create project in workspace

(O Create project at external location

(O Create project in workspace with content at external location

Direstory: [G¥WindRiver¥norkspace¥ ser Project

Browse.
@

In addition, a space entered at the end of the project name is dropped.
El "UserProject "— "UserProject"

<
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% Basic Device Development - - GW Workbench
File Edit Source Refactor Mavigste Search P Fun  MWindow Help
zillmi W0
Project References
L[ Project Explarer 3 == R Close Froject
£
= = Open Wind River Vxiorks 64 Development Shell
% Build Al ¢
Build Project t
Clzan
Build Options

T —
<~

4 Properties for UserProject =1t

fretieee ]| euid Properties G

Resource
Binary Parser
ties

Specify all build properties.
& Build Support and Specs | 4 Build Tools | $ Build Macros | & Build Paths | = Libraries

Build support
(@ Managed build  (makefiles zenerated by the IDE)

GG+ General
Project Info
Project References © Disabled
Refactoring History
Fun/Debug Settings
Task Tags
Validation

Build command: (gmakeprefidk make ~—no-print-directory

Available and enabled build specs:

SH7750gnule Enable All
Disable All

Default build spe [SHF7E0sule v

Active build spec: | SH7750enule v

%}ehug mode.
Restore Defauilts | [__Apply
@

CHAPTER 8 CREATING AND BUILDING USER PROGRAM

On the "Project Explorer" window, select a project
where properties should be set. With the project
selected, select from the menu bar [Project] =>
[Properties].

Select [Build Properties] from the tree view to the
left on the window, and click the <<Build Support
and Specs>> tab. Check that the following item has
been selected for "Available and enable build

specs:".

2> For Q24DHCCPU-V/-VG:
"PENTIUM4gnu"

=> For Q12DCCPU-V:
"SH7750gnule”

Point/’

® When the project has been imported, unsupported build specifications may be displayed for "Available and enable build

specs:".

Since this product supports only the following build specifications, clear the check boxes other than the following build

specifications.
=> Q24DHCCPU-V/-VG: "PENTIUM4gnu"
=> Q12DCCPU-V: "SH7750gnule"

@® The default is in the debug mode. Clear the "Debug mode" check box during operation.

1S4

& Properties for UserProject (=[]
Build Properties e -
Specify all buid properties.
| @ Build Support and Specs | o Build Tooks | $ Build Macros | & Bulld Paths | i Libraries |
[
?/Ow (Ianine.a\ Fedirection raot directary: [ |
roject Info
Project References Note: Leave this field blank ta stare buikd output tosether with the sources, or enter an absolte
Refactoring Histary path {envionment variables are permissible) to redirect the output
Run/Debug Settings Build spec specific settings
Task Taes ctive build spsc: [SHTT50enule v
Walidation
Redirection directory: [SH1750znule ]
@ Thclude paths:
Tnclude directories Generate.
I (MIND BASEMtarsct/h
I MIND_BASE taresth/nrmcoreip -Wp
Add to all
Femave from all
Up
Restore Defaults
©)

1S4

To the next page

9. select "Build Properties” from the tree on the left of

the window.
Open the <<Build Paths>> tab and click the

[ odd... button.
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- 10. Click the button.
% Add include search path to selected build spec [zl Browse..

11. select the include folder on the "Select directory”

Select directory

window.

Click the (] | button.

= I MELSES |
= ) Cru
) cCIEC -
[ CoLIng
[ coPUTOOL

= 5 Dvx
(= ]irclude
7= Trnls :'
£ i | 3
Folder: | Include |
[ Make Mew Folder l [ Ok ] [ Cancel ]

The include folders differ depending on the C Controller module or Setting/monitoring tools for the C Controller module to be
used. For details, refer to the following table.

Setting/monitoring tools for .
C Controller module Include folder
the C Controller module

Q24DHCCPU-V
C:\MELSEC\CCPU4\Q24DHCCPU-WInclude

Q24DHCCPU-VG SW4PVC-CCPU
Q12DCCPU-V (Extended mode) C:\MELSEC\CCPU4\Q12DCCPU-WInclude
Q12DCCPU-V (Basic mode) SW3PVC-CCPU C:\MELSEC\CCPU\DVx\Include

*1 When Setting/monitoring tools for the C Controller module is installed in "C:\MELSEC".

<
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A Add include search path to selected build spec

Walue:

|-IC:/MELSEC/CGP L Dy Te lude |

I_ Browse... H Ok E[ Cancel

& Properties for UserProject

[rype tilter text

<

Build Properties #&=o -

- Resaurce
- Binary Parser
- Build Propertizs

Specify all build properties.

| @ Build Support and Specs | 4 Build Tools | $ Build Macros | £ Build Paths | Libraries

- Builders
G/G++ General

]

- Praject Info
- Project References
| Refactoring Histary
© Run/Debug Settings
i Task Taes
*Validation

Redirection raot directory: | ]

Note: Leave this field blank to stare build output togsther with the sources, or enter an absolute
path fenvironment variables are permicsible) to redirect the outout

Build spec specific settings
Astive build spes: |SHT7E08nule ~

Redirection directory: [SHT750enule ]

& Telude paths:

|

Ihclude directaries Generate...
~IpWIND_BASE) targst/h
~IHOWIND_BASE) target hiwrn/corein
Add to all
Remove from all.

Restore Defaults | [ Apply

Point/’

Click the O, | button. If the following message box appears, click the

CHAPTER 8 CREATING AND BUILDING USER PROGRAM

12. Check that the folder specified on the "Select
directory" window has been selected.

Click the F. | button.

13. Check that the include path of MELSEC added to
"Include directories” in [Include paths:] appears.

Click the F. | button.

| button.

% C/C++ Index configuration changed

2 The C/C++ index needs to be rebuilk to reflect the build property
\g‘) changes you just made.

Do you wish to rebuild the indes: now?

[ remerber rey derision

<

To the next page
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74. on the "Project Explorer” window, right-click a

Fil= Edit Source Refactor Mevieste Search  Project Fun Window  Hel . g s
= — — = project where a file is added. Select from the pop-up
i B iB-0- i@ EF =
1 Project Explarer 5% menu [New] => [File].
=
[ [ Project
Go o [E; Build Toreet
{2 Copy CHri+ [8f DTD
@ Paste Ctri+y K Fi=
3 Delete Delete % File from Templat

Point/’

Various files can be added to the project using the new file addition function ([File] => "New" => "File") or "Refresh".
However, note the following before adding files to the project:

@® Do not add projects with the same name as the project name.

@ |If a file with the same name as the project name exists in the project, do not use the "Rename" function of CW
Workbench for the file.
» Delete the file from the project if possible. (Note that the file is also deleted from the hard disk.)
» Change the file name on the Explorer if the file cannot be deleted. After changing the file name on the Explorer,
execute "Refresh" in the pop-up menu of the project.
« If a file name is the same as a project name and is changed using "Rename" of CW Workbench, the build
cannot be executed.

1S4

15. Enter a file name of a source file for "File name:".

& New File
File Clickthe | Finish button.
Create anew fil resource, "Sample.c" has been entered here as an example.

Enter or select the parent folder:

| zerProject |

1= RemoteSystemzTempFiles
125 UserPraject Gifind River Waeiorks G4 Downlaadable Kernel Madule Praj

|

< i |

Bdvanced »>

@ [ Einishg[ Cancel
<~

To the next page
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Point/’

» Enter a file name with extension (.c, .h, .cpp, .hpp) for "File name:"

» Do not use two-byte characters for a file name. Do not execute the compile for a file that has a name including
two-byte characters, or a compile error occurs.

« If characters that cannot be used or a project name that is already used are entered for "File name:", an error

text appears on the header of the window and the [ Einish ] button becomes disabled.

% Hew File (=1 3]
File

@ 7 is an invalid character in resource name ‘Samp%le.

Enter o select the parent folder

|UserProject ]

2 RemoteSystems TempFiles
125 UserPraject (Wind River Widliorks 64 Dovnloadable Kernel Module Proj

< | &

File name: [Sample.c |

Advanced >>
®

<

16. Edit the source files on the "Editor” window and

AT include the following include files:

B T T I o e e = For Q24DHCCPU-V/-VG

E‘”f’”:g;jf::;,;ﬁg:"(:;;ig;gﬁﬁfﬁ“°°W“‘““‘"” Minciode miraneie 1o LSEe sern Sien Eoncion teader o . Bus interface function: "QbfFunc.h"
S, - MELSEC data link function: "Mdfunc.h"
v s + C Controller module dedicated function:
N "CcpuFunc.h"

> For Q12DCCPU-V
* Bus interface function: "QbfFunc.h"
* MELSEC data link function: "Mdfunc.h"

284
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(2) Adding source file

Follow the instructions below to add a source file that has been already created to the project.

&% C:\WserProject

File Edit VMiew Favorites Tools  Help ﬂ'
- »
@ Back .'\) LE p Search E’— Folders '
Address |E:| CiyUserProject V| G
Folders s Mame =
= |3 UserProject A ChsmnTany
= 3 SIMNTgru E:l CommonDef, b
B [C5) UserProject ]
[ Debug E] Sample.c
[C5) UserProject_partiall
(£ WINDOWS il
< il ] ¥ < Al ] >
Type: C File Date Maodified: 3/23/2010 2:57 4.89 KB i 4y Cormpuker

Ctr+C
Ctrl+y
Delete
F2

Copy

[ Paste

3 Delete

B

Fenames
Move...
Attributes 3

£y Import..
£ Export..

Open Wind River Wiorks 6.4 Development Shell
Ewild Project

Febuild Project

Build Options 3

s Gt [+ Shift+A
2

[@) UserPraoject partialimage.o - [sh/le] (GH7750enule)
UzerProject_partiallmage.o - [shile] (SH7750enule — debug)
[@) UserProjectout - [zhsle] (SH7750enule)

: UszerPrajectout - [zhile] (SHTE0enule - debue?
-fajll Iheludes
7= SHTTE0enule

Completed
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1. Copy the created source file to the current folder of

a project to be added.

[Ex]

Copy EntryWDTInt.c to the current folder of the
project to be added (UserProject) on the Explorer.

Select the project to be added on the "Project

Explorer” window. Select "Refresh” in the pop-up
menu.

3. Thefile "EntryWDTInt.c" copied in the step 1 has
been added to the project.
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8.2 Adding Project

In CW Workbench, multiple projects can be managed on the same workspace by adding other projects following the
instructions below.

El Adding a C Controller module sample project (EntryWDTInt)

1. Right-click on the "Project Explorer" window and
i Basic Device Development — UserProject/Sampl

select "Import...".
File Edit Source Refactor Mavigate Search  Project

M- EH S -0 4B

Tf_j Project Explorer 3 <}=='é> »@-~~—0
 ifind Riv ]

l l:ij'ﬂj Bulld Taregets {SH??EDEHME}

------ i Wind River Launches

l |j].| Ihcludes .
= Co

------ o] Samplec RS o

EEI Pazte

¥ Delete

Rename

Mew
Go Into

Move...
Attributes

£ Export.. g

% Import

Select

Create new projects from an archive file or directory. | g | 5 l Click the [ ﬂext 5 button.

2. Select "General" <> "Existing Projects into

Workspace".

108foid Buippy z'g

Select an import source:

|type filter text |

=== General |
----- [E Archive File

----- B Build Settings

[El Oomblned Workspace Import

{:l Flle System

----- fi) Perspectives

----- B Preferences

#ﬁ Wind River Target Connections

----- Bg Wind River Warkbench Breakpaints
- GAT+H+
[]...E [T
[#-= Deszktop
3

£

t-[2= Remote Systems
H- (= Fun/Debue
(2= Team

-2 Vidiarks Bx o]

®

To the next page
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s Import

Import Projects

Select a directory to search for existing Eclipse projects.

() Select root directory: |

Browse..

I

(O Select archive file: |

Browze..

Projects:

Select All
Degzelect All

Fefresh

i

[JCopy projects into workspace
Wark ing sets

[] &dd project to working =ets

Waorking sets: Select..
©

Browse For Folder

Select rook directory of the projects to import

<

) sntpTimeset &)
= I3 QBFtest
I3 CFChange .
kW DTINk
I3 MationLirk.
IC5) QBFMessage
I3 Scripk
h bl 1|
il | 3
Folder: | EntryWDTInE |
[ Make Mew Folder J L (0] 4 J [ Cancel J

<

To the next page
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3. Select "Select root directory:" radio button and click

the  Browse. . |button.

4. select the folder where the project to be imported is

stored and click the k. | button.
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5. Alistof the projects stored in the folder (including
% Import |
. — subfolders) specified in "Select root directory:" is

Import Projects ) Cw . " .
Select a directory to search for existing Eclipse projects. B d'5P|ayed in PI’OjeCtS. . Check that the PrOJeCt to
- be imported has been selected.
® Select root directory: | O\ MELSEGAOOPU|CGPUTOOLYSample D' [ Bromes. Click the [ Finigh button.
() Select archive file: | | Browze..
Projects:

----- EntryWDTInt {5\ MELSECA COPUNCGPUTOO L\ Sample\ DV S| [ Select Al

Degelect All
a 3

[ Copy projects into workspace

Working sets
[ Add project to working sets

iarkine sets: Select...

@ Mext > Finizh ] [ Cancel

Point/’

When a project created in Wind River Workbench 2.6.1 is imported, the following message appears.

Click the [ | button.

% Project Mieration b__<|

9 ) Exizting project description files in this workspace have to be converted
L | ) to the new Workbench format. If these files are not converted, some
functionality may be compromized, Converting projects may make theze
incompatible with older Workbench verzions.

Carreert now?

[ s ’ Mo ]

108foid Buippy z'g

The following warning message appears on the header of the window when there is no project that can be imported in the
specified folder.

Import Projects
& Mo projects are found to impart B

284
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6. The specified "EntryWDTInt" project has been

: . - . imported to the workspace.
File Edit Source PRefactor Mavieate Search  Project  Bun

Ei‘ﬁ Fﬁ T sl E | (o ﬁ)‘- v D T f? v =R

I}_-, Praject Explorer 3 =0

2 2@
Entry'WDTInt Uiind Rive 0 4 Downloadable
228 UszerProject fiind River WilWarks 64 Downloadable b
mﬁ] Build Targets (SHITS0enule - debug)
- f& Wind River Launches

v&.,' Binaries

|@] Includes

& (2= SHI750enule

1S4

Completed



8.3

How to Build Project

CHAPTER 8 CREATING AND BUILDING USER PROGRAM

Follow the instructions below for how to build the project.

1.

& Basic Device Development — UserProject/Sample.c — GW Workbench

File Edit Source Refactor Mavigate Search  Project Bun  Window  Help

FMO-BE @ iws-0-i- @0 8- 5% -

(@ Getting Started Sam

Iy Wind River Launches Go Inta

[ Includes

..... [ Samplec [= Copy Cirk
@ Paste Citrl
¥ Delete Diele
Fename F2
Mowe
Attributes

f2g Import..

g Export..

Open Wind River VeWorks 6.4 Development Shell
#* Build Project Citrl
& Rebuild Project

Euild Options

GCloge Project g

i Basic Device Development — UserProject/Sample.c — CW Work -

File Edit Source PRefactor Mavieate Search  Project Bun Window  F
ﬁﬁrj' F E @gﬁvcvgg’ﬂvg # B i? T
[ Project Explorer 5 B @7 E\I(@ Getting Sta
EREE ] firy N I
2[00 Build Targetd  —
(gt Wind River [, B0 Into
@'].l Ihcludes =0
: A= =opy Citrl
o g Samplec
@ . [B Paste Citr|
3 Delete Deh
Fename F2
M.
Attributes
2y Import..
- Expart..
Open Wind River WxWorks 64 Development Shell
#* Build Project Cirl
Buwild Optiohs k

284
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On the "Project Explorer" window, right-click on a
project name to be built. In the menu that pops up,
select [Refresh].

On the "Project Explorer" window, right-click on a
project name to be built. In the menu that pops up,
select [Rebuild Project].

71
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3. Ifthe message shown to the left appears, click the

% Build (X]

3 You may need to set the include search path for ‘UserProject’. If the L Continug J button.
\1.1) included files are unambiguous and visible in the workspace, vou can
generate the path now and the build will procesd. )
To manually =et the projects build properties, cancel the build. To
proceed without generating the include search path, click Continue.
[Generate Includes...] [ Cancel ] | Continue
b
S e L e B s s zus— 4. The build process is displayed on the "Build
'cb-i'm'a'.'. p directory BLI]LD]SPEC =SH7750¢nule DEBUG_MODE=0 TRACE=1 clean all a .
:‘:::':zf;r":ﬂ“;;‘f.aﬁ:';z:’;:':z'.’;m::aw/%::'Z’:@z‘;?é‘,ZLi?/SH%sngnmg Console" window.
N[ d LlsevaAEet 1: then od ") UserPrDAect rm —rf NonDebug; fi
i [ va t)ljzvet\s\lmage e ed ) USEVPFDJEC/U:"‘QE“/MEEE et q then mkdir -p " dimame " UserProject partiallmage/NonDebue/Objects/UserPro, " - - - w - - N
e e b e e St i s Pt sl HonDe st sl Build Finished..." is displayed after the build is
i d mar;e IUSiVIP"D!EEDQ/snneeubug/rl,JserPv:yedmA ' then mkdr -p * dimame * i " fircho “buildine L Debe . . R
e e S i completed. Check for error indication (red) on the
= ‘ = "Build Console" window.

Point/’

If the following error "command not found" occurs for the build result, an unsupported compiler may have been used.
Check that only the following build specification has been selected for the <<Build Support and Specs>> tab in [Build
Properties] of the project. If check boxes of build specifications other than the following have been selected, clear them.

([ZF Page 58, Section 8.1)
> Q24DHCCPU-V/-VG: "PENTIUM4gnu"
> Q12DCCPU-V: "SH7750gnule"

Ed Build Gonsole 52 S Feeds (4.‘;] @] Error Lng} E Onnsn\e‘] =0
ANE) 4L G| AR
building UserProject/Debue/Objects/UserProject/Sample.o ~

CHDOCUME™ PS32965L0C ALS ™1 Tempmake1 4208 sh: doc: command not found
@CAMVOP_Byeomorks—6 8 hostyuBE-mind2ybinmsks sxs: #¥ [UssrProject/Debue/Objects/User Project/Sa
Build Failed in Project 'UserProject’ (Process Exit Walue was 2):  2010-07-29 13:18:001 '—
~

@ |If the build result has an error, error information (source file name, line number, and error details) is displayed in red.
Correct source codes in the error part.
Execute the build again after correction. Repeatedly correct and build the source codes until the build result is not

colored red.
Ed Build Gonsole 32 @] Errar Log | Pruperties‘} =8
- =l |8 v &g 4 EEE T

make: remaovineg targets and eb]ects of C/’user/ WS Awb3 2 o HowTo/UserProject /SH7780enule ]
if [~d " LserProject” 1 thenod * UserPru]ect rm -+ Debue; fi
it [-d" Useer]ecp:artlaIImage I thencd ™ szerPro ject partiallmage”; rm -rf Debug;
it [! -d *"dirname UserPrejectjartla\Image/Dehug/Ob eots/ LserProject/Samplea” ] then mkdir -p " "dimame ”
building LIseer]ectJ]alt|aIImagelDahug/Oh]ecls/Usaer]ect/Samplen
Gifuser/ WS b3 2/ v HowTo/UserProject/Sample.c: In function “UserProject’
@G users W wh3 2/ o HowTo/ User Project/Sample.c99: error: stray ¥129' in program
G uzer/ WS b3 2/ cvm_HowTo/ UserProject /Sample.c:89 stray '@ in program
@C\WR\CWW\vanrks—ﬁ4\hﬂst\x86—wm32\h|n\makeexe #k [UserProject partiallmage/Debug /Objects s/ LzerProjec
Build Failed in Project "UserProject’ (Process Exit Value was 2{1 2010-08-26 10:28:33 (Elapset—

< | »

Double-clicking the error line where a source file name and a line number are displayed jumps to the error location of
the source file.

<
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5. After the build is completed, execution file (user

& MonDebug |:HE|F>__<|
B EE Wew ewales Tk REp o program) to be used on the C Controller module is
@ Back - J lﬁ p Search [/ Folders v created.
Address @C:1WindRiverIworkspace\UserPro]’ect\SH??SDgnuIeIUserProiect‘LNDnDebug V| Go If an error occurs durlng the bu"d’ a user program
Al Name ~ Size | Type is not created.
File and Folder Tasks @ctdt.c 1KE Tornado
; " Bleto 1KB o File A file name of the user program is "<Project

Iim Rename this fils LKE OUTFie

By Move this file name.out>".

Copy this Fle (e IS

Folders where a user program is created:

® In Debug Mode:

> For Q24DHCCPU-V/-VG:
<Workspace folder>\<Project name folder>\PENTIUM4gnu\<Project name folder>\Debug

=> For Q12DCCPU-V:
<Workspace folder>\<Project name folder>\SH7750gnule\<Project name folder>\Debug
@ In Release Mode:

> For Q24DHCCPU-V/-VG:
<Workspace folder>\<Project name folder>\PENTIUM4gnu\<Project name folder>\NonDebug

> For Q12DCCPU-V:
<Workspace folder>\<Project name folder>\SH7750gnule\<Project name folder>\NonDebug

When a user program is created on a project imported, the folders above change depending on structures of folders and
projects where the imported project exists.
Check the folders where a user program is created on the imported project.

1S4

Completed
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8.4

Setting Optimization Option

This section explains how to set an optimization option that prioritizes the processing speed.

A Basic Device Developmen

File  Edit Source Refactor Mavigate Search
Bl cillmifs YRS R P R O

[ Build Targets (SH77E0enule!

— UserProjectfSample c - GW Workbench

1.

Bun  Window Help

Cpen Praject

Project References

Ciloge Project

Open Wind River Waiorks 64 Development Shell

g Wind River Launches [iwp Build All 1
i&: Einaries Build Project !
[l Ineludes Clean..

= SH7E0erule

: Samplec Build Options

<

& Properties for UserProject

2.

Bud Propertios 5 -
Resource
' Bivry Parser Specify all build propertias
@ Build Support and Specs | & Build Tools | $ Build Macros | &= Build Paths | =4 Libraries |
G/G++ General Build toak [G-Compiler | [(hew. ] ((Copy. | [(Dekete. ]
Proiect Info
- Project References
- Refactoring History Suffives: [fc |
Fun/Debiue Settines
Task Tots Build output generation
*Walidation (® Generated build output is an object
O Generated build output is a build target
Build target can be passed
Build spec specific settings
Active build spec: [5H77508nle v
Derived suffix [¥o ]
Command: & [echo “building 3" Kccompilerprefixk §TOOL PATHIcesh & A
DebugModeF lask KToolF laes $(ADDED GFLAGS) Kncludesk =]
$(ADDED_INCLLIDES! ~DOFLI= GPLD - =
DTOOL_FAMILY=§TOOL_FAMILY) -DTODL=3(TO0L) -D WRS KERNEL |
Tool Flags: # [$GG_ARGH SPEC) -ansi -Wall —MD -MP ‘
Debug mods flags
Debue mode. | & [& |
Mon Debug mode..| & [-02 —fno-builtin ]
Festare Defaults

<

To the next page
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Select a project where the optimization option is

set. Select from the menu bar [Project] =>
[Properties].

Select [Build Properties] from the tree view to the
left on the window.
Click the <<Build Tools>> tab.
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3. Select "C-Compiler" for "Build tool:".
Build Properties - .
i From Click the Tool Flags.. button.

Resource
" Binary Parser Specify all build properties.

- Build Prapertizs @ Build Support and Specs | # Build Toaks | $ Build Macros | (= Build Faths || B4 Libraries

Builders

-Froject Info e

B

- Project References EreCampilr
Retactoring History Suffixes: |Linker
- Fur/Debus Sottings Partial Imags Linker
‘ Build outp|Librarian
Task Toss Plhssembler
Validation T AT

© Generated build output is a build target
Build tareet can be passed

Build spec specific settings

Auctive build spec: |5HTT508rule v
Derived suffic [*o ]
Cammand: & [echn “building §3" Recompilerprefizh §T00L PATHIcesh % ~

DebuzMadeFlaesk §ToalFlazs% $IADDED GFLAGS) Mhclidesk ]
$(ADDED INGLUDES) -DCPIU=HCPU) - =
DTOOL_FAMILY=F{TOO0L_F AMILY? -DTOOL=${TOOL) -D_WRS_KERNEL %

$(CC_ARGH SFEC) —ansi -Wall -MD -MP

Tool Flags. 7

Debug mode flags
Debug mode.. | & e |
Non Debug mode..| & [-02 —fno-bwittin ]

Festore Defaults
@

Select "C++-Compiler" for C++.

284

4. onthe "Optimization" dialog box, select [Enable

% Gnu Cempiler Options

S maximum speed optimizations]. Check that "-02"

Selected option:

Optimization (1] H " H
I~ Debuccre b : has been added to "Selected option:" and click the
& Cempilation iy $(0C_ARGH_SPEC)
Cutput & [JEnable standard speed optimizations: it
. ?;:S: 7| [FIEnable maximum speed optimizations e k. | button.
Inteeral & [JEmphasize space reduction over speed requkes one of the above) o
Dizgnostics
' Lint Optimized cods genaration

& Tnline functions with less than: nodes

& Maximum size of & loop for unrolling: nodes

& [ Loop strength reduction and elimination of iteration variables:

# [JGombine an instruction that copies ane register into anather

# []Generate position-independent code

& [Reorder instructions to eliminate execution stalls

& [JDon't keep the frame pointer in & register for functions that don't need one

@ Stack

(@ Accumulate arguments on the stack for several function calls and pop them all at once

O Fap the areuments te each function call s soon as that function retums

# Unrall loops

(T number of iterations can be determined at compile time or upon entry to the loop
O Alnays
© Mever

uondo uoneziwndo Bumes g

Point/’

To cancel the optimization option, click . | in "Enable Optimization" on "Optimization" and change the mark to

v (cancel). Check that "-O*" has been deleted from "Selected option:".

1S4

To the next page

75



[tvpe filter text

Resource
Binary Parser

Builders
C/C++ General
- Project Info
Project References
- Refactoring Histary
- Run/Debug Settings
Task Taes
Walidation

Build Properties -

Specify all build properties.

& Build Support and Specs | #° Build Tools | § Build Macros | = Build Paths | B4 Libraries |

| [ new

Build took [G-Compiler [ Gopy. | [Dekete. ]

Suffixes: [fo ]

Build output generation

® Generated build output is an obiect

O Generated build output is a build target
Build target can be passed

Build spec specific settings

Active build spec: |5HTT508rLIe v

Derived suffix [¥o ]

Command: & [echo “building §@" Kccompilerprefixk $TOOL PATHIcesh % |
DebuzModzF laesh ¥ToolFlsesk $ADDED GFLAGS) Mhchudesk =1
$(ADDED INCLUDES) ~DGPU=$(CPL) - =
DTOOL_FAMILY=§TOOL_FAMILY? ~-DTOOL=F(TOOL -D_WRS_KERNEL M|

Tool Flags: # [BGG_ARCH SPEC) -ansi -Wall -MD -MP

Debug mode flags
Debug mode.. | & 2 |
Mon Debug mode..| & [-02 —fno-builtin ]

Restore Defaults Aeply

Check that "-0O2" has been added to [Tool Flags...] in

"Build Properties" and click the 0k |

button.

After the k. | button is clicked, the following

message appears. Click the

& C/C++ Index confieuration chaneed

0 The G/C++ index needs to be rebuilt to reflect the build property
\f) changes you just made.

Do vou wish to rebuild the index now?

[1Remember my decision

[ Yes L\\J [ Mo

e
—
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Completed
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CHAPTER 9 CONNECTING CW WORKBENCH TO
THE C CONTROLLER MODULE

9.1 Setting Target Server

The host (CW Workbench) and the target device (C Controller module) communicate through the target server (on the
CW Workbench) and the C Controller module.
Below is a setting procedure to establish communication.

Host Target device

4 N 4 I

iQ Platform-compatible

Development environment C Controller module
(personal computer)

CW Workbench

( Eclipse framework )

Eclipse
C/C++ Development Tools

( Target server )

Windows

[ Ethernet )

Janiag 18bie] Bumes |6
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9.1.1 Preparing for target server setting

The following settings are required for CW Workbench to connect to the C Controller module through the target server:
+ Setting an IP address of the C Controller module
» Setting a VxWorks image file

The files must be
the same!

Development environment (personal computer) \ C Controller module
IP address:192.168.3.1 IP address:192.168.3.3

Point/

VxWorks image files are required to be copied from C Controller module to the development environment (personal computer).

(1) How to acquire a VxWorks image file from the C Controller module
Use the FTP to copy a VxWorks image file on the C Controller module to a folder on the development
environment (personal computer).
Do not copy the VxWorks image file to a path or a folder that has two-byte characters and katakana.

A VxWorks image file of the C Controller module is stored in "/SYSTEMROM/OS_IMAGEFILE".

=> For Q24DHCCPU-V:
/SYSTEMROM/OS_IMAGEFILE/Q24DHCCPU-V_XXXXX-Y *1

> For Q24DHCCPU-VG:
/ISYSTEMROM/OS_IMAGEFILE/Q24DHCCPU-VG_XXXXX-Y "

> For Q12DCCPU-V (Extended mode):
ISYSTEMROM/OS_IMAGEFILE/Q12DCCPU-V_XXXXX-Y_ModeEX !

=> For Q12DCCPU-V (Basic mode):

/SYSTEMROM/OS_IMAGEFILE/Q12DCCPU-V_XXXXX-Y !

*1 XXXXX: First five digits of the serial number of the C Controller module
Y: Function version of the C Controller module
For how to check serial numbers and function versions, refer to the following manual.
* For Q24DHCCPU-V/-VG and Q12DCCPU-V (Extended mode) :

[ ] MELSEC-Q C Controller Module User's Manual
* For Q12DCCPU-V (Basic mode):

[T C Controller Module User's Manual (Hardware Design, Function Explanation)

Below are the default user name and password to connect CW Workbench to the C Controller module using the
FTP:

* User name: target

» Password: password
If the default user name and password have been changed, use the user name and the password acquired.
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(2) When VxWorks image files are not identical

When the VxWorks image file of the development environment (personal computer) is not identical with that of the
C Controller module, copy the image file from the C Controller module to the development environment (personal

computer). ([Z Page 78, Section 9.1.1 (1))

(3) Checking the network connection
Before setting the target server connection, use the ping command to check that the C Controller module, a
destination of the target server, is connected to the development environment (personal computer) by following
the instructions below.

1. start [Command Prompt] from Windows* Start™! on
the development environment (personal computer).

*1 Select [All apps] on the Start screen or [Start] =>
[All Programs]/[All apps].

=+ Command Prompt

2. Execute the ping command.
Use the IP address of the C Controller module for
the IP address specified for an argument in the ping
command.
The default IP address of the C Controller module is
192.168.3.3 if not changed.

3. Check that the development environment is

=+ Command Prompt

network-connected to the C Controller module.

Janiag 18bie] Bumes |6

bumes Jonias 10bue) Joy bunedaid |16

4. Execute the exit command to terminate the

=+ Command Prompt

Command Prompt.

Completed
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9.1.2 How to set target server connection

Follow the instructions below to set the target server connection.

1. Click the _ii’ button on the toolbar of "Remote

Jﬁ Remote Systems £ T Kernel Objects} =g
AR & v Systems”.
B Local;

: 2. Select "Wind River VxWorks 6.x Target Server
°

Select Remote System Type Connection™ and click the [ Mext >

=ll.'L= button.

|type filter text |

Swstem type:

- (= General

B2 Vaiarks fx

{@ Wind River WxWorks Gx Core Dump Connection
I . ot

ection

©

To the next page
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3. Setthe target connection information for "Backend

Target Server Dptions settingS" as shown in the list below.

& Selected proceszor will be uszed to connect to your tareet without
double—checking against real processor.

Connection information

Backend settines
Backend: |wibrpe v | Processor [SHT720 | [=elect. | ltem Q24DHCCPU-V Q12DCCPU-V
Target name / [P address: |192.168.33 9| Check. |Pet[ ] Q24DHCCPU-VG
Backend wdbrpc
Processor Z5xx SH7780
Kernel imaze
O File path fram tarzet (if available) 192.168.3.3(default)
@ File: | CAMELSECAGCPLN DV Tonle\ G 2DCGPL-V_1 2062-5 | FBromse. IP Address (If the default IP address of the C Controller module

[[] Bypass checksum comparison has been changed, set the IP address acquired.)

Adwanced target server options
[] Werboze target server output

Options: [~R Ci/user/_WS/nb3.2/cmw_HowTo ~Ri -Bt 3 -A v

Gommand Line:

tetavr VY -R Gusers W5/ wb3 2/ cvw_HowTa -RW —Bt 3 ¢ G\ MELSECAVGGPIN DV Taalsh Q1 2D0GF U
W 12052-B -A 19216833

@ [ <Bsok [ Mext> J[ Emsh ][ Cancel |

Select the "File" radio button in "Kernel image" and click

the  Browse... |button.

Look in: |@TDD\S v| 0 ? o ,

LY | 01 2DCGRU-Y 12042-B
| B
dy Recent
Docurnerts
?‘T
£
Desktop

Select the VxWorks image file and click the

N
= button.

My Documents
The VxWorks image file specified here should be the

Clickthe [ Finish | button to start connecting

©

QJ same file as that of the C Controller module. -
ky Computer w
v Acquire the VxWorks image file from C Controller 2
- : ]
@ e oo ¥ (o ] module using FTP. (/5 Page 78, Section 9.1.1 (1)) e
My Metwark, Filez of type: |"_" v| [ Cancel ] 2
S

»

()

2

o

with the C Controller module.

<

Completed

uoIoBUUOD Jonies 1ob.e) 18S 01 MOH 2°1°6

81



9.2 Starting and connecting the target server

After setting the target server, select the added target server on the "Remote Systems" window. Connection and

disconnection can be executed for the C Controller module by clicking the "Connect"( H ) or

"Disconnect"( .;‘:T )button.

El Below is an example of the window when "VxWorks6x_192.168.3.3 (Wind River VxWorks 6.4)" is selected.

K_Hﬁ Femote Systems ©3 =5
£8P B 8 Rk BRT
E’ Local

=R {(Wind Rive

E¢' unconnected | Wind River WiWiorks 6.4

Or select the added target server with the mouse and right-click. Select "Connect" or "Disconnect" from the menu.
Under "Connect", "connected - target server running" is displayed at the bottom of the main window after the target

server is started and connected.
Under "Disconnect”, "unconnected" is displayed at the bottom of the main window after the target server is

disconnected.

K_jﬁ Femote Systems 3 = B
£l ol B|SY
E’ Local

EI% fitfind Rive .2 G4,

”'.';. Debugzer Mfind Fiver W

=% Works B4:5HTTA0 [stateless] (SHTTA0

H-® Kernel Tasks

@' Feal Time Proceszes

R EGMPLout:E - Symbol fils: /SYSTE

----- W ECPCCLoutlxd - Symbol file: /SYSTE

----- T EZSocketCPPForMDuoutlx3 - Symbo

----- 59 ftpdlibout0:® - Symbal file: SSYSTE

- £l C!'IEDG(l}PLI-‘I.-‘j 2062-B0x1 - Symbo %

»

(i

connected — tareet server running | Kernel im.

Point/’

Once the target server is started, the C Controller module is automatically reconnected to the target server after the module
is normally started even if the power supply of the module is turned off and on.

To disconnect the target server, select the connected target server on the "Remote Systems" window and click the
"Disconnect” button.
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Jﬁ Remaote Systems 53 = O
IS S, B Y e R Y = =
E_f Local -

_ Mind Riv Ly
Wind River Target Debugger (hind River Wil
B wiowiorks BASHTTED [stateless] (SH7780
-8 Kernel Tasks
g Real Time Processes
----- 5 ECMPLowt0:E - Symbal file: ASYSTE

=

----- 3 E7SocketCPPForMDoutl=3 - Symbo

88 ftpdLliboutDxs - Symbal file: /SYSTE

L3R O 2DCCPU-Y 12062-B0:1 - Symbo %
| »

C

connected — target server running | Kernel im

The indication of the "Connect" and "Disconnect" buttons switches between enabled and disabled, depending on the status
of connection to the C Controller module.

During disconnection: "Connect"( H ) for enabled and "Disconnect"( ,;"—-T Jfor disabled

During connection: "Connect"( H ) for disabled and "Disconnect"( r: )for enabled

Point/’

The following error message appears if the C Controller module is not running or if the network is not connected while the
target server is under "Connect".

% Failed to Gonnect to Tareet r)_(|

Failed to launch tareet server for connection "AdWorks6ix_192.168.3.3'
{Registry localhost)

Pozsible cause:
Back-end not connected.

Removed dead entry from Regiztry!

@

If the error shown above occurs, check the following:
» The C Controller module is powered on and is running properly.

+ The target server is connected to the C Controller module. (= Page 79, Section 9.1.1 (3))

After the target server is started and connected, select the connected target server to use the Host Shell.
For how to start the shell, refer to the following section.

[ Page 85, Section 10.2
For details on Shell, refer to the following document by selecting [Help] in the menu bar > [Help Contents] > "Wind River
Documentation" £> "Guides" £> "Host Tools" => "Wind River Workbench Host Shell User's Guide, 3.2".
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9.3

How to Check and Change Connection Settings

If the target server cannot be connected to the C Controller module, follow the instructions below to check and change

the connection setting.

= [} Disconnect "VWarks6x_192168.3.3
Jﬂ Remc
g Refresh Properties..

&lt+Enter

WML Puvel Wiy

1. Select the target server on the "Remote Systems"
and right-click to open the pop-up menu. Select
[Properties].

% Tareet Connection @

Target Server Options

Review and customize the tareet server options.

MName |WxWorksfx 19216833

| Shared: [

fssociated target platform: |Wind River WiWorks 64

|

Backend settings

Tareet Server Options | Object Path Mappings | Target State Refresh | Debue Options

\ 4

19216833

Tareet name / I address:

v

Backend: | wdbrpc Ilerocessor: EH??SD

| [ Select. ]I{—
Port: l:l

v

Kernel image
() File path from target (f available)

—Pl@ File: |O:\ MELSECA COPUN DVl Tools CN2DCOPU-V 12052-B

v| [ Browse... ]l

[ Bypass checksum comparizon

Advanced target server options
[¥]We'anze target server output

Options: |—R Ce/MELSEC/CWAM Wark Space /CW Workbench -RiW Bt 3 -&

=

Command Line:

tetavr =\ —R Ci/MELSEC /W Work Space/CW Workbench -RiW -Bt 3 ¢
CAMELSECH SO PLUY D Toolsh G 2DCCPU-W 120582-B -4 19216833

|/‘_?H'I
gy

o] % ] [ Cancel

Check the Backend field.
Enter "wdbrpc" for "Backend".

3. Check the Processor field.

Set "Z5xx" (for Q24DHCCPU-V/-VG) or "SH7780" (for Q12DCCPU-V) for "Processor".
4. cCheck the IP address of the target device (C Controller module).

Set the IP address of the C Controller module for "Target name/IP address".

The default IP address is 192.168.3.3.
5. Check the Kernel image.

Set the correct VxWorks image file.((_ 5~ Page 78, Section 9.1.1)

Do not change the "Advanced target server options" setting. (The default value is recommended.)
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CHAPTER 10How TO DEBUG PROGRAM

1 01 How to Connect CW Workbench to the C Controller
Module

« Set the target server.([_ = Page 77, Section 9.1)
« Start and connect the target server.(_ = Page 82, Section 9.2)

10.2 Starting Shell

On the "Remote Systems" window, select the target server connected to the C Controller module where the shell is
started. In the menu that pops up by right-clicking, select [Target Tools] => [Host Shell] to start the shell.

L WU

=2 UserProj Tarest WTH Console

WTH Conzale Properties

<
L=f Disconnect "Warksfix_ 19216833 Fun Debugger WTH Connection Test

ell

1H Remote Syst

+#£ | &t
E_? Local

ER ]

Refresh Properties.. =
Host Shell Properties

| b

Properties Alt+Enter
Wind Fver

i 1. Click the button.
4 Start Host Shell OvxWorks6x_ 192.168.3 3@ meiw228) E\

(@ Please select the cammand line aptions and press OF to start
the host shell

Options:

[ ot read hame. el rifilization {8l

[ Exectrte: Tel expression aftsr intialization &)

[indicate mods to start sither GITellGdbjomdl.. ¢

[JSet event poll interval tmsec) [defautt=200] (-p)

[IStartup file of shell commands to executs (s)

Other Options:

[l Show this dialoe before host shell starts

2. Shell starts.

Completed
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10.3 Downloading Module

Follow the instructions below to download a module file on the C Controller module.

The module is used for an application, such as to download a file on the memory on the C Controller module and start
a task from the shell.

= = 1. On the "Remote Systems" window, select the target
Jﬁ Femote Swvetems 39 |

£ 082 8 R BIST

server where the module file is downloaded.
Select the target server connected to the C Controller

module for the target server.

2. Onthe "Project Explorer" window, select the

% Basic Device Development - - GW Workbench

File Edit Source Refactor Mavieate Search Projest Run  Window Help modaule file to be downloaded. In the menu that
Al @i-0- i iE@mif- FH eeo A pops up by right-clicking, select [Download

([ Project Explorer 53 HE B @7 T O Geine S VxWorks Kernel Task].

&H Entry'WDTInt Oind River WiWorks 6.4 Downloadable Kernel Module Project? ==
&m TestProj ifind River Wiiorks 6.4 Downloadable Kermel Madule Project)
= &M UserProject tWind River VaWorks 64 Downloadable Kernel Module Project) . .
5. l) Build Targets (SHTS0gnule) "UserProject.out" has been selected for the module file
s Wind River Launches
-4 Binaries here as an example.
UszerProject_partiallmageo - [shle] (SHITEenule)
UserPraject partiallmage.o - [sh/le] (SHT750enule - debug)
UszerPrajectout - [shile] (SHTENenule)

- fafll Includes Hew 3
(= SHT7E0enule
“be| Samplec Open

Cpen With 3

(=) Copy Cirl+G

(B Paste Citr [+

3 Delete Delete
Rename F2
Mawe
Attributes 3

g Import..
3 Export..

Cpen Wind River Wiilorks 64 Development Shell

% Build Project Citrl+Shift+4
2, Rebuild Praject

Build Optionz 3
& Refresh F&

<

2 Bun Viorks Kernel Task
#5 Debue Wiidorks Kernel Task
Do o wernel

284
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@-Ei Local
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& Download Gonfieurations

Create, manage, and run configurations
Select the launch context for executing the launch operations.

CHAPTER 10 HOW TO DEBUG PROGRAM

5 3. Click the button.
@

T B T
H@x 4 Mame: [norryPoirt - User Projectout ~ VlorksBe 19216833

fivp= filter text

8l Launch Gontext () Downinads | #% Projects to Build| £ Gomman |

& G wiliorks Kernel Task
G noEntryPaint - UserProjec VxWorks Kernel Task Download Options

Launch Cantext

8 [ @ o
-8

» Advanced

< | >

- __ Apply. Revert
Filter matched 2 of 2 items.
®

1S4

Completed

The module file "UserProject.out" selected in the step 2
has been downloaded on the C Controller module,
which is a destination of the target server selected in the
step 1.

The following window appears on and after the second
operation.
Select "Launch the selected launch configuration" and

click the Ok | button.

% Launch Configuration Selection

Choose Action

() Warkbench has found one or mare existing launch
configurations that match wour zelection. What do you want to
do®

(%) Launch the selected launch configuration
() Edit the selected launch configuration
() Edit a duplicate of the selected launch configuration

() Create a new launch configuration

Matching "WWorks Kernel Task' Launch Configurations:

See Target Management/Launch Configurations for additional settings.

@ [_ox

J [ CGancel
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10.4 Howto Debug Program

This section explains how to debug a program by using a sample program (EntryWDTInt.c) of the C Controller module
as an example.

(1) Note:

The executing module needs to be built in "Debug Mode" when a project is debugged on CW Workbench.

Y output task
Task name: SmpTask_2
Function name: YWord_WriteRtnTask()

WDT main processing Task start

EntryWDTMain()

b 4

10.4.1 Debugging one task

Connect the C Controller module to CW Workbench.

For details,(_ 5~ Page 77, Section 9.1,Page 82,
Section 9.2).

1. Onthe "Project Explorer" window, select a project
% Device Debug — UserProject/Sample.c — CW Workbenc

File Edit Source BRefactor Mavieate Search  Project  Target to be debugged. Click the ¥ mark on the right side

R o WD - of a debug icon( iﬁ; ) on the toolbar and select
rl}__‘ Project Explorer 53 # Debue fno launch history) r@ [Debug Configurations...] from the pop-up menu.
Debug Az 3

er !
UserProject Miind Fiver Whores-mrerpom
[l Build Tarzets (SHT750enule - debug)
iz Wind River Launches

.4 Pinarias

To the next page
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2. Double-click "VxWorks Kernel Task" to create a new
% Debue Confieurations debug configuration.

Create, manage, and run configurations

& » - .
L1 5 S Configure launch sett
|ty'|:ue filter tesct | |_{|=' - Prezs the 'Mew

----- & fttach Tareet Gortesxt = - Press the 'Dupl

----- ] CG/C++ Application
----- [£] G/C++ Attach to Applicati || ¥ = Press the ‘Dele
----- [c] CAC++ Postmortem I_:lel:ulrig L - Press the ‘Filte
----- [t ] G/T++ Remote Applicatior
..... fx;, Laurch Control - Edit ar wiew an

% Waorks Feal Time Proce: Configure launch pers

7 3- Check that the target server connected to the C

Croate, manage, arud run contigurations Controller module to be debugged has been

o Please enter or select an Entry Point.
selected. Click the Browse. . | button.

T B Er
sEx i Mame: [noEntryPoint - TestProjout - VxWorksfix 19216833
[type filter text =
= {38 Launch Centext . [) Downloads | ¥ Projects to Build| & Sowrcs | = Gommen
3 Attach Target Context
~[£] GG+ Application Vxworks Kernel Task Options
G/G++ fttach to Applical
] G/G++ Postmartem Debu Launch Gantext: £ N B 3

|.[E] G/G++ Remate Applicatic

%, Launch Gontrel = [# @ default (acakhast!

- [V Vitiorksfx 192.16833 (hind River ViWiorks 6.4}

N

<

:h

i N
ER T ask

no =5 lw)

[

o

e

~ General )

Entry Paint: 9 | [Browse. ] L%

Areuments: | | «Q

» Advanced g

~ Debug @

—-

Q

(2]

=

Break on Entry
[] Automatically attach spawned Kerel Tasks

welboid Bngaq 0} moH 0L

4 | 2 Applz o
Filter matched © of 8 items
@

284
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% Entry Points

Select Entry Point

@ Pleaze zelect an entry point

]

Pattern 7 =

ary character, * = any string, < = end of pattern:

Module entry points:

=] IE& Dowvenloads
=B ' EntryWDT[ntout

L StatusOhecthn
& WHSTART TEXT
& WDTlhtHook Rin

& Yiord White RinTazk

Seleot the lsunch context for executing the launch aperations.

TEx|e-

Hame: [EntryWOThain — EntryWDTInt ot - Vecorksfx 19216833

fivpe fitter text

8 Launch Gentext
3 Attach Tareet Context

8) Donnlaads | #*

Projects to Build| & Saurce| £ Comman |

-[T] GAC++ Application
€] GG+ Attach to Application
-[E] G/C++ Postmortem Debugeer

Launch Gontext
[£] C/#+ Remate Application

VxWorks Kernel Task Options

+% Launch Gontral
-0 Wbllorks Kernel Task
Qg nokntryPoint ~ EntryWDT]
" Qp idiorks Real Time Process

= [ @ default {ocalhosty
M WolWorkstx 19216833 Wind River Vockarks 64)

~ General
Entry Foint [EntryW/DTMain ]
Areuments: | ]
» Advanced
~ Debue
Break on Entry
[Vihiitematically sttach spawned Kermel Tasks!
@ T
Filter matched 9 of 9 items.
)

Point /S’

4. select the function (Entry Point) where debugging

starts. Click the ] | button.

[ OF ] [ Cancel
m O Check that the function name selected in the step 4
Create, manage, and run configurations

has been selected for "Entry Point:"

Click the button.

To debug a task created (taskSpawn) from the function specified in "Entry Point:", "Automatically attach spawned Kernel
Tasks" at the bottom middle of the dialog box also needs to be selected.

<

To the next page
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CHAPTER 10 HOW TO DEBUG PROGRAM

6. At first, debugging starts at the beginning of the

€] EntryWDTInt.e 52

/% ¥ output task */ = ] ] PP

 oia TWord WriteRtnTask(); function specified for "Entry Point:" in the Suspend
status.

/t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*t*/

I WDT Main processing 7

void EntryWbTMain ) | « The function specified for "Entry Point:"

i

short ret;

x Start the mwodple Loty monitor task *
ret = taskSpawn (TASE NAMNE 1, . . . . . .
PRTORTTT T, ! « The location being suspended is highlighted in green.
o, . s . .
STACE, The display is in the same form as that of when a task is
(FUINCPTE) StatusCheckRtn, . . .
5.0, 0 0, 0 0,0 0,0, 01; suspended at a breakpoint described in the step 9.
if (rer == ERROR){
printf ("StatusCheckRtn task start error ret = Thd [ *hxH )Y
return;
}
/% Scart T output task =/

rec = taskSpawn (TASK NANE Z,
PRICRITY_160,
o,
STACE,
(FUNCPTR) TWord_WriceRtnTask,
o, o, 0, o, o, o, O, O, O, O

if (ret == ERROR){

T 7. Insertthe breakpoint to a place where a task

operation needs to be suspended.

return;
}
TR R R AT AT R R AR AR ATATR RN RARATATATAR AR ARAAATATTRATAS Adding the breakpgint di3p|ays breakpoint information
/* Module status wonitor processing *f . " T
lfTﬁﬂ‘ﬂ‘ﬁ‘%‘Tﬁﬂ‘ﬂ‘ﬁ‘%‘Tﬁﬂ‘ﬂ‘ﬂ‘%‘Tﬁﬁ**ﬁ?ﬁﬁ**ﬁtﬁ***ﬁtﬁ***ﬁtﬁ***ﬁtﬁ***ﬁtﬁf Inserted On the Breakpolnt W|nd0W.
id StatusCheckRt: . L .
i atuscheckRin{) Clearing the check box of the breakpoint information on
:‘“’“ e the "Breakpoints" window disables the breakpoint being
ong path;
long  plinfal15]: inserted without canceling the breakpoint. 22
long event[4] ; bl
unsigned long  ulBufSize; 8g Breakpaoints 57 =0 2 ;
o
/% Execute QBF_Open *f e (o = = C? =
ret = QBF Open(UNIT, &path):; o & o w . = g3
if(ret != 0){ @, /TestProj/EntryWDTIntc:81 *Planted*, Restricted Scope! Qg
printf ("QEF_Open error ret = %hd ( %hxH )\n", ret, ret); % (0]
return; «Q g
) g«
)
58
@.Q................Q.l..............Q.l.............'.'.. %a
3

To add a breakpoint, double-click on the left edge of the edit window, at the line where the breakpoint is to be set.
The breakpoint can be removed by a double click once more.
0 000000000000 0000000000000 0000000000000 0000000000000000000000

1S4
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%5 Debue 52 =8
s
G O I - iz e

= % Entry'WDTMain = EntryWDTIntout - Wacorkstx: 19216833 [V
= sys-000 (Tazk Mode)
-8 tEntry'WDTMain : 0x49382FEC (Stopped)
=" Ertry WD TMaint — EntryWDTInt.c:43
=" vxTaskEntry( - 0xd80406aa
g tEntryWDTMain : Dx49382FBGC

|A
|l

284

€] EntrywDTInk.c &2

/% Module =tatus monitor processing
ll."ﬁ‘ﬁ‘ﬁﬁﬁﬁ‘ﬁ‘1"1"1"1"TTTTTTTTTT1"1"1"1"1"1"1"1"1"TTTTTTTTTTTTTTTTTTTTTT?

vroid StatusCheckRtn )
{

short ret;

long path;

long plInfo[l5]:

long event [4] ;

unsigned long ulBufiize;

/% Ewecute QBEF Open
ret = QBF Open (UNIT, &path):
if (ret 1= 0] 1
printf ("QEF_Open error ret = 3hd [ $hxH 1hn",
return;
'
ﬁDebug £3
=
i OB IS i e

= % Entry'WOTMain - EntrWDTIntout — WdworksGx 192168.3.3 [\
= sys-000 (Tazk Mode
-8y SmpTask_1 : 0x49CE2074 (Stopped - Breakpoint Hit)

& SmpTazk_2 : DxdFFFEFGC (Runnine?
@ <terminated, exit value: 235245t EntryWDTMain : 049382 F B

|4\

>

1S4
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8.

Click the ( [/) button to restart the task operation.

How to see the status of the task operation
The following table lists how to see the status of the task
operation based on enabled or disabled status of the

three buttons: Resume ( [I=), Suspend ( [J[] ), and

Terminate ( ).

Button status Task operation status
Suspended status (during suspension)
No.1 Click the [J[# button — turns to the status of No.2.
Ok
Click the button — turns to the status of No.3.
Resume status (during execution)
No.2 Clickthe ||| button — turns to the status of No.1.
(N4 )
Click the button — turns to the status of No.3.
No.3
Termination status (debugging terminated)

9. The task operation goes into the Suspended status
at the point where the breakpoint was inserted in
the step 7, and the operation has stopped.

Continue debugging by operations such as checking
variables with step through execution and changing
variables.

10. Use the following step execution buttons on the tool

button on the "Debug" window to continue

debugging.
Icon Description
Step Into
L Steps into the called function and stops at the first line
of the function.
Step Over
el Executes the current line of the function and then
stops at the next line of the function.
Step Return
i Continues execution until the current function has
returned to its caller.




(9= Variahles 532 1 Registers | 89 Expressions | [J Memary Browser
<4 | [TEp 5T R %R
Mame Tvpe Walue
()= ret shart int -1
()= path lorg irt 1228260268
5 o plnfo
B = event  long int[4] Dx49339F B
(= evel long int -286331154
(9= evel lone int -286331154
()= evel long int 286331154
(9= evel long int -286331154
(9= ulBufSi; lone unziene. OxEEEEEEEE

MNarme

plInfo
Binarv:0b01001001001110001001111110000000

(1|3

)= Variables | ifi} Registers 53 & Expressions ﬂ Memary Browser | — O

EE | [T
MHamea Walue Description N
= &4 General General
[O=00000000 .
Dd93E2FED I
(x4 0382 F BC
Ox4236BFC4
(=4 0000000
(x4 B2 DEBAG
O=00000036 b
L) | =
MName : rl |
Binary:0b010010010011100000101111131301100
Decimal:12258419052 B
Hex:0x49352FEC bt
()= "ariables | 193¢ Reeisters | 64" Expressions 53 [ Memaory Browser =08
HEE B R R (87
Expression Tvpe Walug Hame path
Einary:0k01001
= (= event lone int[4]  0x49309FBGC Decimal:l22824
= event[d]  long int -2AA331154 Hex : 0x4935BFC4
0= event[1]  long int 286331154 Default: 122825
9= event[Z]  long int 286331154 oeral:0ll111539
0= eventl3]  lone int -286331154 String:
At mew axpr
S e

9= ariables | 34 Reeisters |87 Expressions | [J Memory Browser 53 =0

- T
[~ L]
| [New Tab]

[DxEC000000

0xEG000000 &3
OxECOOO000

OxECOOO0OOC
OxECODOO01S
OxECODO0Z 4
OxECOOO030
OxECOOO0O3C

00000000 oooooaoo
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0

1S4
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=5 11. Clicking the <<Variables>>,

<<Registers>>,<<Expressions>>, and <<Memory
Browser>> tabs during suspension of tasks
displays each window. Checking and changing
values allows efficient debugging.

"Variables"
Displays the current values of local variables.
"Registers”
Displays the current values of registers.
"Expressions"
Displays the current values of variables in the
Watches window.
"Memory Browser"
Displays the memory dumps on the C Controller
module.

The color of cell changes to yellow when the value has
changed from the previous value by step through
execution or when the value has been changed.

On "Memory Browser", the color of cell does not
change, but the color of font changes to green.

On "Memory Browser", timing to refresh values can be
selected unlike other windows.

Right-click on the "Memory Browser" window. Select
[Update Mode] from the pop up menu.

Always update

3z Fadix P Browser 53 =g

Columns r FE -
& Always i

] On Breakpoint

300 Mar};al

(n[n Copy Addrezz 7 | oL ... -

(n[m Fezet To Baze Address | . ... ... ....

oo Refresh 7 L oo e

AbhAn nnnnnnyﬁ [(alalainlnlninlnl

Update during suspension Manual update (Refresh)

with a breakpoint inserted
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/* Register cimer svent of 500ms cycle. ., 12. Placing the mouse over a variable for a certain

/7 Timer event count ! R . .
Trpe Vale * period of time displays the current value of the
lone intl¢] x4B389F B0 Lo . .
lane int -28A331154 mlrw variable in a balloon.
long int 1) . .
lone int ~208331154 The value displayed in the balloon can be also
19 event[3] lorg int 286331154 . . )
e wem changed like on the "Variables" window.
3
/*% Register a routine for the user UDT error interrupt. L7

ret = (BF EntryWDTInt (path, 0, (FUNCPTE)WDTIntHookRtn):

r:f:i Debue &3 = O

- 13. Click the Terminate ( [® ) button on the "Debug”

window to terminate the debugging session.

R 8 e T

R E S T el

= % EntryWDThMain — TestProjout — Wobiorl
= B8 SHTTAN (Tazk bads)

284

Completed

Point />

To debug the task again, click the W mark on the right side of the debugging icon ( ﬁ}: ) on the toolbar and select the

created debug configurations at the top of the pop-up menu.
The steps 1 to 5 can be skipped.

% Device Debue — EntryWDTInt EntryWDTInt.c — CW Workbench
File Edit Source Refactor Mavieate Search  Project  Target  Bun Window  Help

[ Project Explorer 532 [ Del:uU4 1 EntryWDTMain — EntryitDTIntout -

Debug Az »

Debug Configurations...

& EntrWDTInt_partiallmage. Organize Favorites.. ;:
i m Er'ltr}"WDT[l"lt.Dut {SH??EDETIUIE_ULUUUI il m 1
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10.4.2 Debugging multiple tasks

(1) To debug multiple tasks, execute steps 1 to 5 in "Section 10.4.1. Debugging
one task" as many times as the number of tasks to be started.

(2) The "Debug" window displays the executed tasks.

El An example of when two tasks have been started

L] EntryWDTIntc 52 = O || %5 Debug 57 =0
return; = RN -
¥ (= Uy EntryiDTMain — ErtryWDTIntout - Vsiark s 19216833 [Wdtiorks Kernel 1

=& SHTE0 (Task Mode)

PR e ) & (‘)ﬂ ey WD THain - (493027 G {Stopped)
= — .

reenens N B s =° Entry WD THaind - EntryWiDTit 44

¢ ( ) =" vxTaskEntry () - 0x480496aa

YWord WriteRtnTask()

void L 5| 1Entr WD TMain : 0x49362F B
{ E] % ‘fWiord W ite Rtn Tazk - EntryWDTIntout - Vihiorksf 19216833 [Vahiorks Ke
short ret; =% SHTTE0 (Task Mode)
long path; =@y triord Write FtnTask. - 04 FFFSEA0 éStopped — Breskpaint Hit)
=t

unsigned short dataf[1]; DTt

wxTazkEntry( - 0x480496aa 4
/% Execute OBF Open * o £Wiard MWriteRtnTask : (edFFFEESD
ret = (QBF Open(UNIT, é&path);
if(rec !'= 0)4{
printf ("QBF Cpen error ret = %hd { %hxH )Wn", ret, ret);: . ..
return; The task 2 function is in the Current
! status.

. The source code in the left dialog
/%  Inerement YO - Y¥F every one second w box shows the breakpoint_

P e e R L L LR L PR R L L e

data[0] = 0;

while(1){
£% Write YO - YF walue w4
ret = QBF_Y Out_ WordEx(path, 0, 0, 1, data, 0);
if(ret !'= 03¢

printf ("QEF T Out WordEx error ret = %hd [ %hxH j%n", ret, r
break: T B < | >
55
- A~ b
(3) To debug another task, use the mouse to select another function on the o T
. o2
"Debug" window. gz
- - - - t'a
Switch tasks while multiple tasks are being debugged. S
«Q c
An example of when switching from the task 2 to task 1 3 ‘?U
L€ EntryWiDTInte 52 = B | %% Debue 2 =8 g %
7 N e AN 3
47 ouepue task i (=T EntryWDTMain - EntryWOTIntout - Wabliorketix 19216553 [Viiorks femel Task] @
roid YWord WriteRtnTaski): =] &@ SHT790 (Task Mode?

=8 tEntryWDTMain : 0x49382F BG (Stopped?
—n

TR TR AT AT AT AT AT AT AT AT T

b S e s o =" cTaskEntryt - 0x8804083a
AR R R R R R E AT AT AT AR AALS e

1= % “idord WikiteRtn Tazk — EntryWDThvtout - Wiiorks6x 19216833 [Waiorks Kernel

B4 SHITA0 (Task Made)

void EntryWDTMain ()

short  rec; =8 tviard Wt iteRitn Task : (x4FFFSEQ0 [(Stapped ~ Ereakpoint Hif)
- — =' “idord MikiteRtn Tazk O - EntryiDTInte 187
/% Zrart the module status monito wf = wrTaskEntry ) - Dx480406aa
ret = taskSpawn (TASE NANE 1, W toiard W ite Rt Task : hed FFFSESD
PRIORITY_ 150, -
o,
STACK,
[FUNCETR] StatusCheckRen, The task 1 function is in the Current
) o, o, o, o, o, 0, 0, 0, 0, 0y: status.
if (ret == ERROR]{ L
printf ("StatusCheckRtn task start error ret = %hd [ $hxH The SeIeCted fUnCthn IS now
, return; : displayed.
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10.5 How to Execute Dynamic Printf

This section explains how to execute Dynamic Printf.

Dynamic Printf is a function to dynamically insert or cancel the printf statement when debugging the program without
embedding the printf function to the source code with the similar operation as that of the breakpoint.
Dynamic Printf is only compatible with Q24DHCCPU-V/-VG.

D 1. On the "Editor" window, open the source file which
| AtomTestProcpp 27

is a target for debugging, and right-click the left

short mdTest (void) { edge section
long path = 0O;

Toegele Breakpoint ]

to open the pop-up menu.
Select [Add Dynamic 'printf'...] from the pop-up
menu.

¢ fdd Dynamic printf..

Breakpointz 3
Tracepointz 3

Add Book mark...
Add Tazk. .

«  Show Guick Diff Citr [+Shift+2)
Show Annotation
Show Line Numbers

Falding 3 LE“
Freferences...
2. The "Dynamic 'printf' Properties" dialog box
@ Dynamic 'printf Properties X
Dynamic 'printf' Location and Arguments f;}:/ appears.
T“ Enter the printf statement to be displayed when
b oreasosar o v N debugging the program for "Printf (...)" with the
same text format as the argument to be written in
Gereral | Source Lookup | Status | Scope|  Advanced|

el it the printf function, and click the button.
File Path &, |/ATOMTest/AtomTestProcpp | [Browse. ]
Line |208 |
Printf {3 |"path=3d"path |

Enabled
[Verbose Made

CIcondition | ]
[Cskip Gount | |
@

1S4
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CHAPTER 10 HOW TO DEBUG PROGRAM

3. The printf statement entered for "Printf (...)" is
Bg Breakpoints 53 =0

X % & e w | le =R
B printfe" path=%4" path) /ATOMTest/ tamTestProcpp 208

added on the "Breakpoints" window.

The execution result is displayed on the "Console"
window.

> To display the result of Dynamic Printf on the "Console"

® Debue Gonfigurations

Create, manage, and run canligurations ﬁ window, select "Allocate Console (necessary for input)"
on the <<Common>> tab of the "Debug Configurations"

= Eow
fBx B3 Mame: [mdTest - Q24DHOGPU-V SHout - 024DHCGP -V sh
bpeflered ] 18 Launch Context | &) Downloads [#% Projects to Build | &/ Source | = Gamman d 1a |og bOX
427 Attach Tareet Context oo
£ (R4DHCCPU-Y SH HIT i
3 Q24DHCCPU-Y_SH HIT (1) Olgeal file
[E] C/C+ Application Oshared file: | ][ Browse.
[£] G/Cr+ Attach to Application
[£] G/G++ Postmartem Debugger Display in favorites menu Gonsole Encoding
[E] C/Cr+ Femote Application [ % Debue © Default - inherited {M5332)
. Launch Gontrol a] Ooter
=G Vxiorks Kemel Task 13 Download
O miTest - QZ4DHCCRU-Y SHou
G Volrks Real Time Process Standard Input and Output
[V llacate Goneale Facessary for npit)
[CIFik: |

Workspace.. | | File System. | | Variables..

1uLd o1weuAq 8jnoex3 o} MOH S0l
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CHAPTER 11 TROUBLESHOOTING

The following table lists errors that occur during use of CW Workbench and their solutions.

Category

Problem

Reference

Basic operation

The CW Workbench installer has stopped working half way through. Or the installer has
terminated suddenly during installation.

Page 99, Section 11.1 (1)

A message "The install root of your Wind River Workbench installation could not be
located!" appears and CW Workbench cannot be started.

Page 99, Section 11.1 (2)

A message "Workspace in use or cannot be created, choose a different one." appears
and CW Workbench cannot be started.

Page 99, Section 11.1 (3)

A patch has been applied, but the display does not change.

Page 100, Section 11.1 (4)

The install menu of the plug-in software cannot be found.

Page 101, Section 11.1 (5)

Help on an FTP server does not open.

Page 102, Section 11.1 (6)

The message "The application was unable to start correctly (0xc0000142). Click OK to
close the application." appears and the debug function cannot be used.

Page 102, Section 11.1 (7)

Two shortcut menus with the same name are displayed in the Start menu.

Page 102, Section 11.1 (8)

The GNU compiler of VxWorks 6.8 cannot be used in a command line Shell.

Page 102, Section 11.1 (9)

You have received a permanent license file, but do not know how to use it.

Page 103, Section 11.2 (1)

You do not know how to delete a permanent license file.

Page 103, Section 11.2 (2)

License
An error message with a title of "License Not Found" appears when CW Workbench is
. 9 PP Page 103, Section 11.2 (3)
started or being operated.
An error "command not found" has occurred and the build is not executed. Page 104, Section 11.3 (1)
An error "no input files", "No Such file", or "No such file or directory" has occurred. Page 105, Section 11.3 (2)
An error "Build target "/ /nnnn_partiallmage" used in build target " " not found" has
9 . yyyy P g getyyyy Page 105, Section 11.3 (3)
occurred and the build is not executed.
The following build errors have occurred:
Building "xxx.sh: syntax error near unexpected token yyy_partiallmage/Debug/Objects/nnn"

"xxx.sh: cannot execute binary file"
"Makefile:xxx: *** missing separator. Stop"

"yy.o: command not found ... No such file or directory"

Page 106, Section 11.3 (4)

.out file is not created.
The build terminates with a message "Generation of makefiles started."

Page 106, Section 11.3 (5)

Target server

CW Workbench cannot be connected to the C Controller module.

Page 107, Section 11.4 (1)

When "Connect" is executed on the "Remote Systems" window, an application error
occurs and CW Workbench cannot be connected to the C Controller module.(Failed to
Connect to Target)

Page 108, Section 11.4 (2)

connection )
The connection status of the Remote Systems suddenly changes from "Connected" to
"Disconnected".
The selected target connections are not imported. Page 108, Section 11.4 (3)
.out file cannot be downloaded on the C Controller module. Page 109, Section 11.5 (1)
Downloading

.out file sometimes cannot be downloaded on the C Controller module.

Page 109, Section 11.5 (2)

Installation using
a temporary
license

After an LAC code and user information are entered and the button is

clicked, an error message appears and the installation does not progress.

Page 110, Section 11.6 (1)
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11.1 Basic Operation

(1) The CW Workbench installer has stopped working half way through. Or the

installer has terminated suddenly during installation.
This problem occurs when characters other than alphanumeric characters, an underscore "_", and a hyphen "-"
have been used for the folder name of the installation location specified at first on the CW Workbench installer.
+ Action
Use the following characters for the folder name of the installation location and reinstall CW Workbench:
» Alphanumeric characters
» underscore "_", hyphen "-" (Space cannot be used)

(2) A message "The install root of your Wind River Workbench installation could

not be located!" appears and CW Workbench cannot be started.
This problem occurs when characters other than alphanumeric characters, an underscore "_", and a hyphen
have been used for the folder name of the installation location on CW Workbench.
+ Action

Uninstall CW Workbench. Use the following characters for the folder name of the installation location and

reinstall CW Workbench:

* Alphanumeric characters

 underscore "_", hyphen "-" (Space cannot be used)

(3) A message "Workspace in use or cannot be created, choose a different one."
appears and CW Workbench cannot be started.

This message appears if the folder of the workspace specified at first is being accessed by another CW
Workbench.
* Action
Click the OE. button. Select a different folder for the Workspace folder displayed again or
terminate the CW Workbench that is operating already.
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(4) A patch has been applied, but the display does not change.

Old data may be in the cache.
* Action
When starting CW Workbench, specify "-clean" in the argument.
After CW Workbench has been started with "-clean" specified, delete "-clean" from the boot argument.
(Keeping "-clean" being specified slows the startup of CW Workbench.)

(a) How to specify "-clean"
1. Select the CW Workbench shortcut on the desktop.
In the menu that pops up by right-clicking on the

Open

RN &5, shortcut, select [Properties].

Scan with Officescan Client
Pin ko Skart menu

Send To ¥

Zuk
Copy

Zreate Shorkcut
Delete
Renarme

Propetties

2. Entera space at the end of "Target:" on the CW

CW Workbench Properties

General | Shorteut |Com|:atibilit}I || Security |

Workbench Properties.

Enter "-clean" after the space and click the

I@ O Workbench (] | button.

Target type: Application

Target location: eclipse

Target: |rm\xBB-win32\ecIipse\wrwb-xBB-winSZEH

= -cleary

Start in: |C:\W’indF|iver |

Shortout keyw: | Mone |

Rur: | Mormal windaw M |

Cormment: | |

[ Fird Target... ] [Ehangelcon... ] [ Advanced... ]

[ Ok J[ Cancel ][ Apply ]

(b) How to delete "-clean"

In the step 2 of [How to specify "-clean"], delete the space and "-clean”. Click the k. | button.
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(5) The install menu of the plug-in software cannot be found.

To install the plug-in software, select from the menu bar [Help]=> [Install New Software...].
If [Install New Software...] cannot be found on the Help menu, the display mode of CW Workbench is "Basic

Device Development".

Check the current display mode of CW Workbench on the title bar.

% Basic Device Development — CW Workbench

File Edit Source Refactor Mawvigate Search  Project  Bun  Window  Help

* Action

Change the display mode of CW Workbench to "Advanced Device Development".

(a) How to change the display mode

m Help

Mewy Windows
Mewy Editar

Open Perspectiv
Shiow Wiew K

[T Bazic Device Development
m Device Debug
£H Remate System Explarer

4 o+ - D w

Import Perspectives..
Export Perzpectives.

Cuztamize Perspective.
- P Cither...

Save Perzpective fz.

) B Advanced De. |E »
=0)

= i B Advanced Device Development

[ Bagic Device Development
[E Device Debue

Other..

1S4

% Advanced Device Development - - CW Workbench

Eile Edit Source PFefactor Mavigate Search  Project  Target Bun Window Help

<

Welcome

E (@) Help Contents
7 37 Search
Dvnamic Help

Kew Azzizt. Crl+Shift+L
Tipz and Tricks..

Cheat Sheets..

Check for Updates

() Getting Started

1.

Select from the menu bar [Window] => [Open

Perspective] => [Advanced Device Development].

Another way to change the display mode is click the

Open Perspective icon ( @ ) at the upper right corner

of CW Workbench and select "Advanced Device
Development" from the menu displayed.

Check that the title display of CW Workbench has

been changed to "Advanced Device Development".

To install the plug-in software, select from the menu

bar [Help]=>[Install New Software...].
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(6) Help on an FTP server does not open.

(7)

'Failed to launch help' is displayed and Help does not open even when 'HELP' is selected in the menu of the FTP
server included in this product.

The currenly used operating system may not support the FTP server included in this product.
* Action

Check if the currently used operating system supports the FTP server included in this product.
[ 7 Page 16, Section 2.3

The message "The application was unable to start correctly (0xc0000142).

Click OK to close the application.” appears and the debug function cannot be

used.
This symptom occurs when using Windows 10 version 1703 (Creators Update), and the following functions
cannot be used.
» Target connection function (The connection with a target cannot be performed.)
» Debugging function (Debug cannot be executed.)
+ Action

Apply Windows update KB4025342(0S Build 15063.483) for Windows 10 version 1703 (Creators Update)
for a personal computer.

(8) Two shortcut menus with the same name are displayed in the Start menu.

» When "setup.exe" is executed on a personal computer running Windows® 8 or later,
one or more [Registry], [FTP Server], or [VxWorks COMx] shortcut menus may be displayed under [Wind
River] of Windows® Start ™.

*1 Select [All apps] on the Start screen or [Start] => [All Programs]/[All apps].
« Action

Uninstall CW Workbench first, then execute "Install.vbs" to install CW Workbench again.({_ 5 Page 27)

+ CW Workbench whose software version is not supported by Windows® 8 or later is installed.
* Action

Use the installer of CW Workbench whose software version is "F" or later.([_ 5 Page 16)

(9) The GNU compiler of VxWorks 6.8 cannot be used in a command line Shell.

+ When CW Workbench is installed using "setup.exe" on Windows® 8 or later, [VxWorks Development Shell]
starts command line Shell of VxWorks6.4.The GNU complier of VxWorks6.8 cannot be used.

OSelect [Wind River] 2> [VxWorks Development Shell] from Windows” Start™!

*1 Select [All apps] on the Start screen or [Start] => [All Programs]/[All apps].
« Action

Uninstall CW Workbench first, then execute "Install.vbs" to install CW Workbench again.(_ 5 Page 27)

+ CW Workbench whose software version is not supported by Windows® 8 or later is installed.
+ Action

Use the installer of CW Workbench whose software version is "F" or later.([_ 5 Page 16)
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11.2 License

(1) You have received a permanent license file, but do not know how to use it.
Store the obtained permanent license file in the license folder in the personal computer where CW Workbench
has been installed.

[ Page 25, Section 5.3

(2) You do not know how to delete a permanent license file.

Delete all the files in the license folder in the personal computer where CW Workbench has been installed.

[T Page 26, Section 5.4

(3) An error message "License Not Found" appears when CW Workbench is
started or being operated.

An error has occurred with the license file being used for CW Workbench.

[ Page 115, Appendix 2

asusor] Z'LL
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11.3 Building

104

« Action

From the tree view to the left on the "Properties" window on the "Project" menu, select "Build Properties" and
click the<<Build Support and Specs>>tab. (The window shown below is the one that appears when the

project name is "UserProject".)

Check that the compilers that cannot be used have not been selected for "Available and enabled build

specs:".

Since the "Available and enabled build specs:" supports only the following build specifications, clear the
check boxes other than the following build specifications.
> For Q24DHCCPU-V/-VG: "PENTIUM4gnu"

=> For Q12DCCPU-V: "SH7750gnule"

% Properties for UserProject

|type filter text

- Resource

- Binary Parzer
®Euild Properties

- Builders

- GG+ General

- Project Info

... Project References
. Befactoring History
- Fun/Debug Settings
- Task Tags

- alidation

(1) An error "command not found" has occurred and the build is not executed.

A compiler that cannot be used on CW Workbench has been selected.

- B

[] sH7780diable
[ aH7780enu
SH7TEOenule

Build Properties v
Specify all build properties.
@ Euild Support and Specs | ¥ Build Tools | $  Build Macros | & Build Paths | = Libraries |
Euild zupport
(& Managed build  {makefiles generated by the IDEY
() Dizabled
Build command: ¥makeprefix¥ make ——no—print-directary
freailable and enabled build specs:
[[] sH7750diab Enable All

Disable All

Fename...

COpy..

Delete..

Default build spec: |SH??50€nuIe

S

Active build spec: |SH??50gnuIe

"]

Debug mode

Resztore Defaults Apply

[ o |

Cancel ]
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(2) An error "no input files", "No Such file", or "No such file or directory" has

occurred.
The source file may not have been registered in the build project.

« Action
Create a file with extension of ".c" or ".cpp" or change the file name to the one with extension of ".c" or

".cpp". Register the file in the build project and execute the build.

[ 5 Page 57, CHAPTER 8
Follow the instruction below to change the file name.

» With "Sample" selected, select [Rename] from the menu that pops

Eile  Edit Source Refactor Mavieate Search  Project Bun Window  Help . Lo
up by right-clicking.

Ailwils m i%-0- 14 PEn iR
[i},Project Explorer &2 = Q:D @&~ 0@
& EntryWDTInt Mind River WxWorks 6.4 Downloadable Kermel Module Project) * Select "Sample" and press the I key

= tg' UserProject fifind River WiWorks 64 Downloadable Kernel Module Project?
{8 Build Targets (SHT750enulz)
]
{5 Wind River Launches
1‘,—? Binaries
[t Iheludes
(7= SHT7a0enule

22 TestProj Mind River Wiorks 6.4 Downloadable Kernel Module Project) I

Efcample

New

Cpen
Cpen With 3

2 Copy Cir+G

¥ Delete Delete

Rename

Move..
Attributes >

(3) An error "Build target "/yyyy/nnnn_partiallmage" used in build target "yyyy"
not found" has occurred and the build is not executed.

The file with the same name as the project name may have been renamed.

+ Action
Create a project and move the source file from the project where an error occurs.

[=" Page 57, CHAPTER 8

Point />

The following message appears when the project where an error occurs is deleted. Check if the box is selected or cleared.
Do not delete the necessary file by mistake.

Clicking the 0K button with the box cleared ([])

9P fre you sure vou want to remove project 'Sample’ from the workspace? deletes the pI'OJeCt from the workspace. The file remains on
&/ the hard disk.

% Delete Resources

Clicking the k. button with the box selected

([+]) deletes the project from the workspace. The file is

Presview > ]L 0K ] [ Cancel ]

deleted from the hard disk at the same time. (The deleted file
cannot be recovered.)
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(4) The following errors occur:
"xxx.sh: syntax error near unexpected token 'yyy partiallmage/Debug/Objects/
nnn"
"xxx.sh: cannot execute binary file"
"Makefile:xxx: *** missing separator. Stop"
"yy.o: command not found...No such file or directory"

The source file name may have symbolic-characters.
* Action
Remove the following symbols and characters that cannot be used from the file name with an error message

nnn and from the name of the source file added to the project.

Symbols/characters that cause a build error

# Sharp sign

Ampersand

Apostrophe

( Parenthesis

) Parenthesis

Semicolon

= Equality sign

Grave accent

Two-byte characters

Katakana

The following symbols that cannot be used for file names on Windows also cannot be used for the source
file.

Symbols that cannot be used for file names on Windows*

\ Backslash

/ Slash
Colon

* Asterisk

? Question mark

" Quote

< Less than

> Greater than
Pipe

(5) .out file is not created.

The build terminates with a message "Generation of makefiles started."
The source file name may have a dollar sign "$".
» Action
Remove "$" from the source file name.
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1.4 Target Server Connection

(1) CW Workbench cannot be connected to the C Controller module.

(a) Case 1: [Log Console] A message "Differences for module "xxxxxxx" segment's

address" appears.
The VxWorks image file of the C Controller module is not the same as that of CW Workbench.
+ Action
The VxWorks image file of the C Controller module must be the same as that of CW Workbench.

[ 5 Page 77, Section 9.1

(b) Case 2: A message [Failed to Connect to Target] appears.
The C Controller module may not be connected to the CW Workbench network or the IP address setting may
be wrong.
+ Action
Check the following items:
* The C Controller module is on.
» The C Controller module is properly operating. (There is no error.)
» The LAN cable connector connecting the development environment (personal computer) to the C
Controller module has been fully inserted into the LAN socket.
» LEDs of all the LAN ports to which LAN cables are connected are lit.
+ IP addresses of the development environment (personal computer) and the C Controller module have

been set properly.

Point/’

If the problem is not solved by applying the corrective actions shown above, delete the cache folder and restart CW Workbench.
(It may take time to startup at the first time after deleting the cache folder.)

® Cache folder
"C:\Documents and Settings\User name\.workbench-3.2.X.XXXXXXXX-XXXX"
User name: The user name currently logged on
x: A value added automatically

(c) Other causes
The host name of the development environment (personal computer) where CW Workbench has been installed
may have only one character or more than 15 characters or may have two-byte characters or one-byte
katakana.
+ Action
Set the host name of the development environment (personal computer) within 2 to 15 alphanumeric
characters.

107

uoloBUU0) Jenteg 18bie] |




108

(2)

()

When "Connect" is executed on the "Remote Systems" window, an error
occurs and CW Workbench fails to be connected to the C Controller
module.(Failed to Connect to Target)

The connection status of the Remote Systems suddenly changes from
"Connected" to "Disconnected”.

This error occurs when: "Connect" has been executed on the "Remote Systems" window of CW Workbench on
multiple personal computers for one C Controller module, or "Connect" has been executed on the "Remote
Systems" window of CW Workbench multiple times on one personal computer for one C Controller module.
* Action
Do not execute "Connect" on multiple personal computers to one C Controller module at the same time.
Do not execute "Connect" on the Remote Systems window of CW Workbench multiple times to one C
Controller module.

The selected target connections are not imported.
This error occurs when: the multiple target connections are selected, and the import operation is executed.
* Action
Import the target connections one by one which are not imported.
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11.5 Downloading

(1) .out file cannot be downloaded on the C Controller module.

[Problem Occurred] message
Possible Cause:
Download failed.
The path or the file name of the .out file to be downloaded has characters or symbols that cannot be used.
+ Action
Remove the following symbols and characters from the path or the file name of the .out file to be
downloaded. Select the file again and download it.

Downloading fails if an .out file has the following symbols/characters for the path and the file name:

' Apostrophe

* Asterisk
Colon
Semicolon
Period

< Less than

> Greater than

/ Slash

? Question mark

Space

Two-byte characters

Katakana

(2) .out file sometimes cannot be downloaded on the C Controller module.
The path of the VxWorks image file selected for the target server setting may have two-byte characters or
katakana.

+ Action
Remove two-byte characters and katakana from the path of the VxWorks image file.

[T Page 77, Section 9.1
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11.6 Installation using a temporary license

(1) After an LAC code and user information are entered and the [ pext > |

button is clicked, an error message appears and the installation does not
progress.

Error message

£ Error Message &|
Errors occurred while trying to verify the entered License Authorization
Caode (LAC)

« Action

The following table describes how to respond to the error text displayed in the "Error Message" dialog box.

Error text Action

The HTTP server you are trying to access may not be responding properly.
HTTP Server: Bad Gateway Try to install the product later.
If the problem still remains, try to install the product another day.

The personal computer in use may be connected to the Internet via a proxy server.

Unknown Host: Use the button and go back to the "Installer-Online Update

Settings" window. Check the box of "Connect to internet using proxy server" and
configure the proxy server setting.

The personal computer in use may not be connected to the Internet.

Check that the personal computer can be connected to the Internet.

Unable to read repository at Install the product on the personal computer being connected to the Internet.

When the personal computer is connected via a proxy server, conduct the measure of
the error text (Unknown Host) above.
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APPENDIX

Appendix 1 Installation and Uninstallation of the Plug-in
Software

This section explains how to install and uninstall the plug-in software, an extended function of the product.

For details on the plug-in software functions, refer to the following Wind River Workbench document provided by Wind River
Systems, Inc.

O Click the menu bar [Help] => [Help Contents] => "Wind River Partners Documentation" — "Eclipse
Workbench User Guide" — "Tasks" — "Updating and installing software"

Appendix 1.1 Installation

Follow the instructions below to install the plug-in software.

Point /s’

® When installing the plug-in software, check that the product is in the "Advanced Device Development" mode.

% Advanced Device Development — - C'W Workbench

File Edit Source Refactor Mavigate Search  Project  Targ

If "Basic Device Development" is displayed on the title bar, change it to "Advanced Device Development" by one of the
following methods:

+ Select from the menu bar [Window] => [Open Perspective] =>[Advanced Device Development].
» From the menu that appears by clicking the Open Perspective icon ( %}' ) at the upper right corner, select
[Advanced Device Development].

@ The plug-in software install method explained in this chapter is the same as the general install method of Eclipse3.5. To
install the plug-in software, follow instructions provided by plug-in software manufactures.

@ For details on how to use the plug-in software installed, contact the plug-in software manufacturer.

@ |[f the installed plug-in software does not properly operate, check if the software can be operated in Eclipse3.5 on public
operating environment provided by the plug-in software manufacturer.
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Weloome
(?) Help Contents

jﬂ?’ Search

Dyvrnamic Help

kew fzsizt. Ctr+shift+L

Tipz and Tricks...
Cheat Sheets...

Check for Updates

<

1. Toinstall the plug-in software, click the menu bar

[Help] => [Install New Software...].

2. Click the Putton on the Instal
window.

Available Software
Select a site of enter the location of a site.

odl

Bdd.. ]

type or select a site vl L

iork, with
Find more software by working with the 'fvailable Software Sites' preferences.

|type filter text

Name Wersion

1@ There is na site selected

Detailz

[¥]Shaw only the latest verzions of available coftware [ ] Hide items that are already installed

[¥] Group items by catesory What i already installed?

[¥]Contact all update sites during inztall to find required software

Mext > Einizh

Cancel

< Back

@

|| | [ Local..

Mame:

Location: |I'1tt|3:,"1-’r | [ frchive..

J
]

a4

@

Cancel

3. Enter information for the Name and Location fields.

Click the (] | button. A web site where the

plug-in is software installed is added.

An Archive file downloaded from the web site can be also selected for the "Location" field by clicking the

putton

<

To the next page
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—: Package that can be installed from the added
% Install =5 E]E‘
Available Software r;' Location is acquired.

Select a site or enter the location of a =ite. "Pending..." is displayed as shown on the window

to the left while the information is being acquired.
Wiork with: |type or select a site vl | Add.

Find more software by working with the 'fvailable Software Sites' preferences.

|type filter text |

Name Wersion
[] Pending

Detailz

[¥]Shaw only the latest verzions of available coftware [ ] Hide items that are already installed
[¥] Group items by catesory What i already installed?

[¥]Contact all update sites during inztall to find required software

@ < Back Mext > Einish

284

& nstall CEX 5. When the package that can be installed has been
Available Software g acquired, package names are displayed.

Select a site of enter the location of a site. Select a package tO be insta"ed.

Clickthe [ Mext > button to install the

Work with: [tvpe or select a site v| L Add.. J

Find more software by working with the 'Available Software Sites' preferences.

plug-in software.

|type filter text |

Name Wergion
[]000 Babel Languzge Packs in Italian
abe| Lany J =

[]000 Babel Laneuzes Packs in Klingon
[]000 Babel Langusge Packs in Korean

Detailz

[¥] Show only the latest versions of available software [ ] Hide items that are already installed
[¥] Group items by catesory What is already installed?

[ Contact all update sites during install to find required software

uone|jeisu| || xipueddy

alemyog ul-Bniq ay) Jo uone|eIsulun pue uone|elsy] | xipuaddy

@ < Back Mext > Einish

284

Completed
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Appendix 1.2  uUninstallation

Follow the instructions below to uninstall the plug-in software.

Select the menu bar [Help] => [About CW

1.
H.H ‘ H.H Q ‘ Workbench Features].

Click the button.

CIEI 1

@ Installation Details

: 2. Open the <<Installed Software>> tab and select the

packages to be deleted.

Click the button to uninstall the plug-in
Mame Wersion Id 23

LI software.

Installed Software | nstallation History | Features | Plug=ing | Gantiguration |

abel Laneuase Pack for mode 7.,
Babel Language Pack for modeling mz 3500200531

orgeclipseba
| >

|1

[ Update... ][uninstall... J Properties

284

Completed
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Appendix 2 License Errors

This section explains license errors that may occur when CW Workbench is started and being used.

Appendix 2.1 License errors

CW Workbench operates as below when a license error occurs at start-up and during use.

(1) Click the |

* The license is repeatedly checked.

| button on the License Not Found dialog box.

(2) Click the Cancel | button on the "License Not Found" dialog box.

» The license check ends and CW Workbench continues to operate.

If the Cancel button is clicked with license errors occurred and CW Workbench continues to

operate, CW Workbench operates with the following functions disabled:

Functions that cannot be used Functions that can be used
when a license error occurs even when a license error occurs
* Project creation « Editor function (such as new creation, editing, saving, and
* Building searching)
« Target server connection « Importing
» Downloading « Exporting
» Debugging

SJ0JI 8suddI | Xipuaddy
$J0113 9suddIT g Xipuaddy
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Appendix 2.2 License error message

When a license error occurs, an error message "License Not Found" shown below appears. Check error details based
on an error number.

b License Mot Found El

Launchine the Wind River Debug Server (DFW) Backend failed to obtain the
license: Overall Licenze for the Wind River Warkbenich

1) »| Cannot find licernse file
The licenze files or zerver netwark addreszes) attempted are
2) » lizted below. Usze LM _LICERSE FILE to use a different licenze file,
of cohtact wour software provider for a license file
Feature: WE_MIOREBEMCH
Filename: o licenze¥WRSLicenze lic
3) p| Licenze path: C¥WRECWANE|icenee CWRECWMAN 2% license, G iOP_B¥licenze;
Co¥ M ELS ECEC MY licenee G0 P licenze,G¥Wind River¥licenzeC#ind River —
¥license¥zwrzlicenze lico¥¥licenze¥WRS Licenze lic
4) p| FLE®Im errar: —1,359.| Swstem Errar: 2 " Mo such file or directary” < 5)

Far further ntarmation, reter to the FLEXIm End Lzer Manual,
available at T macrovizion.com”

i Hetry |[ Cance!

No. Item Description
1) | Error text Displays an error outline within 80 characters.
2) | Error details™ Displays error details and solutions/measures within 3 to 5 lines.
3) | Support information”! Information such as a license file name and path information

Displays the error number and minor number of a license error case.(A number used
when an FLEXIm vendor provides support. This guidebook omits explanations.)

e FLEXIm error: O, A

. ) O : Error number (-1 to negative number)
4) | FLEXIm error information

A : Minor number (1 to positive number)
In the error message above (FLEXIm error: -1,359)
Error number: -1
Minor number: 359

Indicates the latest error number and error text of the operating system acquired before a

5) | System error information L
license error.

*1 These items are not displayed for the specific errors.
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Appendix 2.3 Main license error messages and recovery
procedures

This section explains license errors that may occur during operations of CW Workbench and how to recover from
errors.

(1) Trial period expiration
If CW Workbench is used with a temporary license, the following license error message appears after 31 days
since installation.

% License Mot Found

Launchine the Wind River Debue Server (DFW) Backend failed to obtain the
licenze: Overall Licenze for the Wind River Workbench

Feature haz expired

Feature: W WIRKEBEMZH

Expire date:  31-may-2010

License path: CH¥WRECWE|icense¥awrzLicenze lic,C¥WRECYM =¥ |icenze;
CEMOP_B¥license G ELS ECHECYYE license GO P license G¥Wind River -
¥licenze, ¥ Wind River¥licenze¥anrz Licenze lic ¥ licenze¥WRS Licenze.lic

FLEXIm error: —10,32

For further information, refer to the FLEXIm End User Manual,

available at “wenw macrovisioncom” .

| Betry |[ Cance!

(a) How to recover from the error
Acquire a permanent license and overwrite the file to use CW Workbench.

$J0413 9sudd| g Xipuaddy

salnpasold Alanodal pue sabessaw J011d 9suddl| ulely € Xipuaddy
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(2) Use of an illegal license

If there is an error in host information to be registered when a permanent license is acquired, the following license
error message appears.

Point />

When "DISK" is selected and a DISK serial number other than the one on the C drive is specified on the Permanent License
Application Form, the same error occurs.

Enter a DISK serial number on the C drive for the Host ID.

When there are multiple drives on the development environment (personal computer) in use, do not enter a DISK serial
number other than the one on the C drive for the Host ID.

% License Mot Found

Launchine the Wind River Debug Server (DFW) Backend failed to obtain the
licenze: Overall Licenze for the Wind River Warkbench

Iwalid host

The hoztid of this svstem doss not match the hostid

zpecified in the licenze file

Feature: R MIOREBENCH

Hostid: 00000000002k

Lizenze path: C¥WindRiver#licenze¥WRSLicenze lic W RECWMY 2% license;
CEWRECYY A icenzeCEWOP_B¥license,CG¥MELS ECEC A licenze CntOR -
¥licenze CEWind River¥licenzefawrzLicenze licc ¥ license¥WRSLicenze. lic

FLEXIm errar: -957

For further infaormation, refer to the FLEXIm End User Manual,

available at T macrovizion.com”

i Betry |[ Zancel

(a) How to recover from the error
Recheck the Host ID of the personal computer where CW Workbench is being used.
* If the Host ID is wrong:
Apply for license transfer using License Transfer Certification Agreement Form in
PermanentLicenseApplicationForm.xls stored in the DVD-ROM. The Host ID to enter here is as follows:
Enter the wrong Host ID registered last time for "Previous License".
Enter a new Host ID to be registered this time for "New License".
* If the Host ID is correct:
Contact your local Mitsubishi service center or representative.

118



APPENDIX

(3) Use of a file without license

When CW Workbench has been installed using an install key, the following dialog box appears at the startup of
CW Workbench.

Click the  Cancel | button to start CW Workbench. After the startup, the following license error message

appears.
+ Dialog box

FLEXIm License Finder X
*r'our application was not able to obtain a licensze
becausze the FLE®Im lizense manager could nat

determing where ta find the licenzing data it
needs. Pleaze chooze one of the fallowing:

() Specify the License Server
() Specify the License File

Copyright [c] 1933, 2003 M acrovision Corporation

* License error message

% License Hot Found

River Wiorkbench

Invalid licenze file syntax

Feature: W WIRKBENCH

Licenze path: C3Windr ver¥license¥zwrs License lic, ¥ PElicense;
c¥¥|icenze¥WHRS Licensze. lic

FLEXIm error: —2413. Svstem Error 277

For further information, refer to the FLEXIm End User Manual,

available at “wanw macrovisioncom”
. Retry | [ Zancel

@ Wiarkbench build failed to obtain the license: Overall Licenze for the Wind

$J0413 9sudd| g Xipuaddy

(a) How to recover from the error
Apply for a permanent license. After acquiring a permanent license file, apply it to the development
environment (personal computer).

salnpasold Alanodal pue sabessaw J011d 9suddl| ulely € Xipuaddy
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Appendix 3 comparison with Wind River Workbench

The following table shows the comparison between this product (SW1DND-CWWLQ12-E, SW1DND-CWWLQ24-E)
and Wind River Workbench.

Appendix 3.1 comparison with SW1DND-CWWLQ12-E

O: Applicable, X: Not applicable

CW Workbench Wind River
Item (SW1DND- Workbench
CWWLQ12-E) 2.6.1
Windows 10 (Home, Pro, Enterprise, Education, loT Enterprise 2016 LTSB)
Windows 8.1, Windows 8.1 (Pro, Enterprise)
Windows 8, Windows 8 (Pro, Enterprise) X
Operating system O
Windows 7 (Professional, Ultimate, Enterprise)
Windows Vista (Ultimate, Business, Enterprise)
Windows XP (Professional SP3) or later O
Framework Eclipse (Workbench basic function) Ver.3.5 Ver.3.2
SH7750gnule (Compiler for C Controller module (GCC for SH-4A Little Endian o o
compiler)
Compiler
SIMNTgnu (Compiler for VxSim) (GCC for VxWorks Simulator Windows % o
compiler))

Project system and
build system (Project
creation and
management)

VxWorks Downloadable Kernel Module Project (A project used for normal
application development. Applications which are executed in the kernel mode of @] O
VxWorks 6.x are created)

Wind River VxWorks Simulator (A simulation function to execute debugging by
Debugger running the Wind River VxWorks application on the operating system without X O
the actual devices)

MemScope (Specify memory leaks by monitoring the memory usage.)

ProfileScope (Analyze bottleneck of tasks by conducting statistical analysis on
coding status.)

Runtime analysis tool | StethoScope (Analyze memory leaks by monitoring variables and data x )
structures in real time.)

System Viewer (Analyze deadlock and task execution order by monitoring
interrupt task status, CPU utilization, etc.)
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Appendix 3.2 comparison with SW1DND-CWWLQ24-E

O: Applicable, X: Not applicable

CW Workbench 5 X
Wind River
Item (SW1DND-
Workbench 3.2
CWWLQ24-E)

Windows 10 (Home, Pro, Enterprise, Education, loT Enterprise 2016 LTSB)
Windows 8.1, Windows 8.1 (Pro, Enterprise) X
Windows 8, Windows 8 (Pro, Enterprise)

Operating system O - @@
Windows 7 (Professional, Ultimate, Enterprise) A
Windows Vista (Ultimate, Business, Enterprise) O
Windows XP (Professional SP3) or later

Framework Eclipse (Workbench basic function) Ver.3.5 Ver.3.5
PENTIUM4gnu (Compiler for C Controller module (GCC for Intel Atom Z5xx o o
compiler))

Compiler
SIMNTgnu (Compiler for VxSim (GCC for VxWorks Simulator Windows « o
compiler))
Wind River VxWorks Simulator (A simulation function to execute debugging by
running the Wind River VxWorks application on the operating system without X O
the actual devices)

Debugger
Dynamic Printf (A function to dynamically insert or cancel the printf statement
when debugging the program without embedding the printf function to the O O
source code with the similar operation as that of the breakpoint)
MemScope (Specify memory leaks by monitoring the memory usage.)
ProfileScope (Analyze bottleneck of tasks by conducting statistical analysis on
coding status.)

Runtime analysis tool | StethoScope (Analyze memory leaks by monitoring variables and data X O
structures in real time.)
System Viewer (Analyze deadlock and task execution order by monitoring
interrupt task status, CPU utilization, etc.)

I-vZOTMMO-ANALMS Uim uosuedwo) z'¢ xipuaddy
UOUSQYIOAN JOATY PUIA Yim uosuedwo) ¢ xipuaddy
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Appendix 4 support

Appendix 4.1 Technical support assistance service regarding C
Controller module

For technical support assistance service regarding C Controller module, refer to the table below.
If you are not sure which type the inquiry belongs to, please contact us. Please note that inquiries other than MELSEC-

related inquiries may not be able to be answered.

Type Inquiry Where to contact

« Functions and specifications of C Controller module

» Specifications and usage of the dedicated function library
provided by Mitsubishi Electric Corporation

MELSEC- « Setting/monitoring tools for the C Controller module, and

related functions and specifications of CW Workbench

« Functions and specifications of the Mitsubishi products to
be used with C Controller module (such as units and

[~ 5 Information and services
For further information and services, please consult your
local Mitsubishi representative

MELSOFT)
« Functions and specifications of VxWorks, API functions
Operating provided by VxWorks, and general inquiries regarding ) .
; Wind River Systems, Inc.
system- programming related to VxWorks Lo
) e L ) . URL: http://www.windriver.com
related « Functions and specifications of Wind River Workbench and
Tornado
Plug-in . ) . .
« Inquiries regarding the plug-in software to be used with CW )
software- . . Plug-in software manufacturer
related Workbench or Wind River Workbench
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TRADEMARKS

Microsoft, Windows Vista, and Windows XP are either registered trademarks or trademarks of Microsoft Corporation in the
United States and/or other countries.

Intel and Pentium are either registered trademarks or trademarks of Intel Corporation in the United States and/or other
countries.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

VxSim, VxWorks, and Wind River are either registered trademarks or trademarks of Wind River Systems, Inc.

Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

The company names, system names and product names mentioned in this manual are either registered trademarks or

trademarks of their respective companies.

®

In some cases, trademark symbols such as '™' or ™" are not specified in this manual.
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